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All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in 
any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior 
written permission of SEIKO EPSON CORPORATION. The information contained herein is designed only for use 
with this EPSON printer. EPSON is not responsible for any use of this information as applied to other printers.

Neither SEIKO EPSON CORPORATION nor its affiliates shall be liable to the purchaser of this product or third 
parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, 
or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the 
U.S.) failure to strictly comply with SEIKO EPSON CORPORATION’s operating and maintenance instructions.

SEIKO EPSON CORPORATION shall not be liable for any damages or problems arising from the use of any options 
or any consumable products other than those designated as Original EPSON Products or EPSON Approved 
Products by SEIKO EPSON CORPORATION.

EPSON, EPSON Stylus, and ESC/P are registered trademarks and ESC/P 2 is a trademark of SEIKO EPSON 
CORPORATION.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of 
their respective owners. EPSON disclaims any and all rights in those marks.

The ENERGY STAR emblem does not represent EPA endorsement of any product or service.

Copyright © 1997 by Epson America, Inc. 4007159
5/97

front.fm5  Page ii  Friday, May 9, 1997  1:34 PM



iii

FCC Compliance Statement
For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to 
Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference 
in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not 
installed and used in accordance with the instructions, may cause harmful interference to radio or television 
reception. However, there is no guarantee that interference will not occur in a particular installation. If this 
equipment does cause interference to radio and television reception, which can be determined by turning the 
equipment off and on, the user is encouraged to try to correct the interference by one or more of the following 
measures.

◗ Reorient or relocate the receiving antenna. 

◗ Increase the separation between the equipment and receiver.

◗ Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

◗ Consult the dealer or an experienced radio/TV technician for help.

WARNING

The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC 
Certification of this device and may cause interference levels which exceed the limits established by the FCC for 
this equipment. It is the responsibility of the user to obtain and use a shielded equipment interface cable with this 
device. If this equipment has more than one interface connector, do not leave cables connected to unused 
interfaces. Changes or modifications not expressly approved by the manufacturer could void the user’s authority to 
operate the equipment.

For Canadian Users

This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment 
Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le materiel brouilleur du 
Canada.
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Introduction

Your EPSON Stylus® COLOR 1520 printer is the ideal output 
device for business communication pieces—such as 
presentations, signs, banners, maps, color comps, checkplots, 
iron-on transfers, and backlit displays—or any project you 
create. Using resolutions up to 1440 × 720 dpi (dots per inch), 
you get amazingly realistic photographic images, vivid color 
graphics, superb grayscale images, and razor-sharp black 
printing for crisp text and detailed line art.

With its large format print capabilities and versatile, built-in 
paper feeding options, the EPSON Stylus COLOR 1520 lets you 
print on virtually any media, of almost any size, including single 
sheets, continuous fold paper, and roll paper. You can even 
switch between printing on continuous paper and single sheets 
by flipping a lever.

The printer software for Microsoft® Windows® and Apple® 
Macintosh® computers provides advanced color management, 
with adjustable levels of brightness, contrast, saturation, and ink 
colors. Support for ColorSync™ 2.01 and Windows 95 ICM 
ensures printouts that closely match the colors on your monitor. 
You can also perform many printer maintenance procedures 
right from your computer, such as cleaning and aligning the 
print heads. And EPSON’s extensive online help can guide you 
through printer operations in real time.

With standard parallel and high-speed serial ports and optional 
network connectivity, setting up your printer is fast and easy. 
EPSON’s specially formulated, quick-drying ink and wide 
variety of ink jet media give you the best quality output and 
offer the most flexibility for getting the results you want.

Note:
Also included are the 
EPSON Plot! program 
and EPSON’s protected 
mode Autodesk® Device 
Interface (ADI)® plotter 
driver.

EPSON Plot! lets you 
print HPGL or HPGL/2 
plot files on your printer. 
See Appendix B for 
details.

The ADI plotter driver lets 
you use your printer with 
AutoCAD® 386 (DOS 
Extender) releases 10 
and higher that support 
ADI plotter drivers. See 
the README file on the 
ADI plotter driver diskette 
or printer software 
CD-ROM for more 
information.
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PC System Requirements
To use your printer and its software with a PC, your system 
should have:

◗ An IBM® compatible PC with at least a 386/25 MHz or 
faster processor (486/25 MHz or faster for Windows NT)

◗ DOS, Windows 95, Windows 3.1x, Windows for 
Workgroups 3.11, Windows NT™ 4.0, or Windows 
NT 3.51

◗ At least 16MB of RAM 

◗ At least 20MB of free hard disk space for storing images 
(50MB or more is recommended)

◗ VGA, Super VGA, or better display adapter and monitor

◗ Double-speed CD-ROM drive (quad-speed or faster 
recommended) for installing the printer software from the 
CD-ROM

◗ A shielded, twisted-pair parallel cable (6 to 10 feet long) to 
connect your computer to the printer; the cable must have 
a D-SUB, 25-pin, male connector for your computer and a 
36-pin, Centronics® compatible connector for the printer.

For PC network interface options and the additional system 
requirements they may have, see Appendix A.

Macintosh System Requirements
To use your printer and its software with a Macintosh, your 
system should have:

◗ Any Macintosh or Power Macintosh model except the 
Macintosh +, Macintosh 512, or PowerBook™ 100

◗ System 7.1 or later

◗ At least 8MB of built-in RAM (16MB or more is 
recommended)
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◗ Double-speed CD-ROM drive (quad-speed or faster 
recommended) for installing the printer software from the 
CD-ROM

◗ At least 20MB of free hard disk space for storing images 
(40MB or more is recommended)

◗ VGA, Super VGA, or better display adapter and monitor

◗ Standard Apple System Peripheral-8 serial cable or 
equivalent (RS-422, 8-pin mini DIN male/male)

For Macintosh network interface options and the additional 
system requirements they may have, see Appendix A.

How To Use Your Manuals
To set up your printer and install your printer software, see the 
Quick Setup booklet. This User’s Guide contains the following 
information:

Chapter 1, “Basic Printing,” gives step-by-step instructions for 
everyday printing with Windows or Macintosh.

Chapter 2, “Custom Printing,” tells you how to print special 
projects with custom settings for print quality, special effects, 
and color management.

Chapter 3, “Printing on Special Media,” gives guidelines for 
selecting the right paper or other media for your print job and 
instructions for loading it in your printer.

Chapter 4, “Managing Print Jobs and Network Printing,” 
explains how to manage print jobs, check printer status, and set 
up your system for network printing.

Chapter 5, “Using Your Printer with DOS,” tells you how to 
use your printer with DOS applications, including selecting 
printer software for DOS, changing printer settings using 
default-setting mode, aligning the print heads, selecting 
character tables, and using printer commands.

intro.fm5  Page 3  Friday, May 9, 1997  1:39 PM



Introduction

4

Chapter 6, “Maintenance and Transportation,” gives 
instructions for replacing ink cartridges, cleaning and aligning 
the print heads, and cleaning and transporting the printer.

Chapter 7, “Troubleshooting,” provides solutions for any 
printing problems you may have.

Appendix A, “Using Optional Interfaces,” lists the optional 
interface boards and gives instructions for installing and using 
them.

Appendix B, “Using EPSON Plot!,” gives instructions on 
installing and using the EPSON Plot! program to print HPGL 
or HPGL/2 plotter files on your printer.

Appendix C, “Specifications,” provides the technical details on 
your printer, ink cartridges, and EPSON media.

A Glossary and an Index are included at the end of the book.

Warnings, Cautions, Notes, and Tips

You’ll find this information throughout your manual:

Warnings must be followed carefully to avoid bodily injury.

Cautions must be observed to avoid damage to your 
equipment.

Notes contain important information about your printer.

Tips contain additional hints for great printing.
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Where To Get Help
EPSON provides customer support and service through a 
network of authorized EPSON Customer Care Centers. Dial 
(800) 922-8911 for the nearest location or the following 
services:

◗ FaxAdvice access to EPSON’s technical information library 

◗ Literature on current and new products

◗ The location of your nearest Authorized EPSON Reseller or 
Customer Care Center 

◗ Technical information on the installation, configuration, 
and operation of EPSON products

◗ Customer relations

For answers to commonly asked questions about EPSON 
products 24 hours a day, seven days a week, call EPSON Sound 
Advice at (800) 442-2110.

You can purchase ink cartridges, paper, manuals, accessories, 
and parts from EPSON Accessories at (800) 873-7766 (U.S. 
sales only). In Canada, please call (800) 873-7766 for dealer 
referral.

If you need help using software with an EPSON product, see 
the documentation for that program for technical support 
information.

Electronic Support Services

You can access helpful tips, specifications, DIP switch or 
jumper settings, drivers, FAQs, sample files, application notes, 
and EPSON product bulletins 24 hours a day, seven days a 
week, using a modem and one of the online services below.
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World Wide Web

From the Internet, you can reach EPSON’s Home Page at 
http://www.epson.com. 

EPSON Download Service

You can call the EPSON Download Service  at (800) 442-2007. 
Set your communications software to 8 data bits, 1 stop bit, no 
parity. Modem speed can be up to 28.8 Kbps. 

EPSON FaxAdvice Service

You can access EPSON’s technical information library by 
calling (800) 442-2110 and selecting the appropriate phone 
option. You must provide a return fax number to use 
FaxAdvice.

EPSON Forum on CompuServe 

Members of CompuServe® can type GO EPSON at the menu 
prompt to reach CompuServe’s Epson America Forum. As an 
owner of an EPSON product, you are eligible for a free 
introductory CompuServe membership, which entitles you to 
an introductory credit and your own user ID and password. 
To take advantage of this offer in the U.S. or Canada, call 
(800) 848-8199 and ask for representative #529. 
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ENERGY STAR Compliance
As an ENERGY STAR Partner, EPSON has determined that this 
product meets the ENERGY STAR guidelines for energy 
efficiency.

The EPA ENERGY STAR Office Equipment program is a 
voluntary partnership with the computer and office equipment 
industry to promote the introduction of energy-efficient 
personal computers, monitors, printers, fax machines, and 
copiers in an effort to reduce air pollution caused by power 
generation. 

Energy-saving Tips

Here are a few tips you can use to be even more energy-wise:

◗ If your monitor isn’t ENERGY STAR compliant, turn it off 
when you’re not using it.

◗ Turn off your computer, printer, and monitor each day 
when you are done using them.

◗ Use the print preview option in your software so you can 
catch errors before you print something.

◗ Send e-mail rather than distributing memos. Not only is 
this faster, but you’ll save paper and storage space too.

Important Safety Instructions
Before using your printer, read the following safety instructions 
to make sure you use the printer safely and effectively.

◗ Turn off and unplug the printer before cleaning. Clean 
with a damp cloth only. Do not spill liquid on the printer.

◗ Do not place the printer on an unstable surface or near a 
radiator or heating vent.
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◗ Do not block or cover the openings in the printer’s cabinet 
or insert objects through the slots.

◗ Use only the type of power source indicated on the printer’s 
label.

◗ Connect all equipment to properly grounded power 
outlets. Avoid using outlets on the same circuit as 
photocopiers or air control systems that regularly switch 
on and off.

◗ Place the printer near a wall outlet where the plug can be 
easily unplugged.

Placez l’imprimante près d’une prise de contacte où la fiche 
peut être débranchée facilement.

◗ Do not let the power cord become damaged or frayed.

◗ If you use an extension cord with the printer, make sure 
the total ampere rating of the devices plugged into the 
extension cord does not exceed the cord’s ampere rating. 
Also, make sure the total of all devices plugged into the wall 
outlet does not exceed 15 amperes.

◗ Except as specifically explained in this User’s Guide, do not 
attempt to service the printer yourself.

◗ Unplug the printer and refer servicing to qualified service 
personnel under the following conditions: 

If the power cord or plug is damaged; if liquid has entered 
the printer; if the printer has been dropped or the cabinet 
damaged; if the printer does not operate normally or 
exhibits a distinct change in performance. Adjust only those 
controls that are covered by the operating instructions.
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Even if you are familiar with other types of printers, be sure to 
read through the following list of precautions before operating 
your ink jet printer:

◗ Do not put your hand inside the printer or touch the print 
heads during printing.

◗ Under normal circumstances, ink will not come out of the 
cartridges. If it does get on your skin, wash it off with soap 
and water. If it gets in your eyes, flush them immediately 
with water.

◗ Keep ink cartridges out of the reach of children.

◗ Do not dismantle the ink cartridges or try to refill them. 
This could result in damage to the print head.

◗ Once you install an ink cartridge, do not open the clamp or 
remove the cartridge except to replace it with a new one. 
The cartridge may become unusable otherwise.

◗ Install the ink cartridge immediately after you remove it 
from its package. Leaving the cartridge unpacked for a long 
time before use may result in reduced print quality.

◗ Do not use an ink cartridge beyond the date printed on the 
cartridge carton. For best results, use up the ink cartridges 
within six months of installing them.

◗ Do not shake an ink cartridge; this can cause leakage.

◗ Always turn the printer off using the POperate button. 
When this button is pressed, the Operate light flashes 
briefly then goes out. Do not unplug the printer or turn off 
the power to the outlet until the Operate light is off.

◗ Before transporting the printer, make sure the print head is 
capped in the far right position and the ink cartridges are in 
place.

◗ If you use a printer stand, make sure it keeps the printer 
level and can hold up to 66 lb (30 kg). Secure the printer 
cables to a leg on the stand so they don’t interfere with 
paper feeding.
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It’s easy to print all your color and monochrome (black ink) 
documents with your EPSON Stylus COLOR 1520. First you 
have to set up your printer and install the software following the 
instructions in the Quick Setup booklet. Then read this chapter 
to find out about the following:

◗ Printing from Windows

◗ Printing from a Macintosh

◗ Using online help

◗ What to do when the printer lights come on

Printing from Windows
When you want to print from a Windows application, you 
choose Print from the File menu. You can then choose which 
pages to print, the number of copies, and other options from 
your application’s Print dialog box. When you click a button in 
the Print dialog box, you can select additional settings using 
your printer software, such as whether you want to use color or 
black ink. 

The following sections tell you how to do the following:

◗ Set printer software options from Windows applications

◗ Change the default printer software settings

◗ Check your printer’s status while you print

Basic Printing

Note:
If you print from DOS 
applications, see 
Chapter 5 for instructions 
on using your printer with 
DOS.

For instructions on 
printing HPGL or 
HPGL/2 plot files, see 
Appendix B.
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Setting Printer Options from Windows 
Applications

This section describes the options you’ll need to set for all your 
everyday printouts. See Chapter 2 for information about 
advanced settings for special print jobs. 

Follow these steps to check printer settings from your word 
processor or other Windows software:

1. Choose Print or Print Setup from the File menu. 

If you choose Print, you first see your application’s Print 
dialog box containing the settings you change most often, 
including the number of copies and the pages you want 
printed.

If you choose Print Setup, you first see a list of printers to 
choose from.

2. Make sure your EPSON Stylus COLOR 1520 printer is 
selected, and then click the Printer, Setup, Properties, or 
Options button. (You may have to click a series of these 
buttons, depending on the program you’re printing with.) 
You see the printer software’s dialog box:

:

Note:
The settings you select 
through your Windows 
application usually apply 
only until you exit that 
application. Then the 
driver settings may return 
to the driver’s default 
values or the Windows 
default values selected as 
described on page 1-5.

For more information 
about printer settings, 
click the Help button. 
With Windows 95 and 
Windows NT, you can 
right-click any item on the 
screen and then click 
What’s This?

Main tab
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3. If you don’t see the dialog box shown in step 2, click the 
Main tab.

4. Make sure the Mode option is set to Automatic so the 
printer software can determine the best settings according 
to the Media Type and Ink settings you make. This is the 
easiest way to get good printing results for all kinds of 
documents, on all types of paper.

5. Choose the Media Type you want to print on from the 
following list (you may need to scroll through the list). If 
you are not sure which setting to select for your media, refer 
to the table on page 3-3.

◗ Plain paper

◗ 360 dpi Ink Jet Paper

◗ Photo Quality Ink Jet Paper

◗ Photo Quality Glossy Paper

◗ Photo Quality Glossy Film

◗ Ink Jet Transparencies

◗ Ink Jet Back Light Film

◗ Ink Jet Canvas Cloth

The type of media you choose determines the Print 
Quality setting (resolution) you can use. 

6. Choose Color or Black ink. If you’re printing black text or 
a draft, or if you want colors to print as varying shades of 
gray, select Black for faster printing.

7. Set the slider to Quality or Speed. This lets you choose 
between high resolution printing or faster printing on the 
media you’re using. (The slider is not available for certain 
media types and may not set the highest available 
resolution.)

8. Click the Paper tab and choose your paper feeding source.

For printing at the highest 
resolution (SuperFine 
quality at 1440 dpi), you 
need to use one of the 
photo quality media, the 
back light film, or the 
canvas cloth. For the best 
printing at any resolution, 
always use EPSON media.
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The default Paper Source is Auto Sheet Feeder, for the 
built-in sheet feeder at the front of your printer. (For 
instructions on printing with other feeders, see Chapter 3.)

9. Choose the Paper Size setting, number of copies, collation 
options, orientation, and printable area. (Your software 
application may let you control some of these settings. 
With Windows NT, there are no collation options.)

10. Click the Main tab and check the Current Settings box on 
the bottom of the menu to see if the other settings are 
correct for your document. If you need to adjust them, use 
Advanced mode as described in Chapter 2.

11. Click OK when you’re finished checking your settings. The 
dialog box closes.

12. In your application’s printing dialog box, click Close, OK, 
or Print. (You may need to click a series of these buttons, 
depending on the program you’re printing with.)

While you’re printing, the EPSON Despooler dialog box 
appears, showing the printing progress and the status of your 
printer. (With Windows NT, you don’t see the Despooler.) See 
“Checking Printer Status” on page 1-7 for more information. 

Click to select your 
paper size

Click to select your 
paper source

Note:
Whenever you change the 
Paper Source, Paper Size, 
or Orientation settings, 
check the printer 
illustration in the dialog 
box to see how your 
document will print.

If you load your paper long 
edge first, select a 
landscape paper size, 
such as Letter 
(Landscape), and then 
select your print 
orientation so the printer 
knows which way you 
loaded the paper.

Keep in mind that some 
application software may 
have paper size and 
orientation settings that 
override your printer 
software settings.

To cancel your changes 
and exit the printer 
software, click the Cancel 
button at the bottom of 
the menu at any time.
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Setting Default Printer Options

When you change printer settings through a Windows 
application (as described above), the settings apply only to the 
application you’re using. If you want to adjust the default 
settings for all your Windows applications, you can access the 
printer software through the Windows 95 or NT printer 
properties, or the Windows 3.1 Control Panel. 

Make sure all your software applications are closed before you 
start. If not, you’ll have to close and then reopen them to have 
the new default settings take effect.

Setting Default Options in Windows 95

1. Click Start, point to Settings, and then point to Printers. 

2. Right-click the EPSON Stylus COLOR 1520 icon. 

3. Select Properties, then click the Main tab. You see the 
Main printer settings dialog box.

4. Change the settings as described on page 1-2 and click OK. 
Any changes you make become the default settings for all 
your applications and documents. 

Setting Default Options in Windows 3.1 

1. Double-click the Control Panel icon in the Main group. 

2. Double-click the Printers icon. 

3. Select EPSON Stylus COLOR 1520 from the list of printers 
and click Setup. You see the Main printer settings dialog 
box.

4. Change the settings as described on page 1-2 and click OK. 
Any changes you make become the default settings for all 
your applications and documents. 

Note:
Some application settings 
override printer software 
settings (such as Paper 
Size or Orientation), so
it’s a good idea to check 
the settings in your 
application before you 
print.
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Setting Default Options in Windows NT 4.0

1. Click Start, point to Settings, and then point to Printers. 

2. Click the EPSON Stylus COLOR 1520 icon.

3. Open the File menu and select Document Defaults. You 
see the Main printer settings dialog box.

4. Change the settings as described on page 1-2 and click OK. 
Any changes you make become the default settings for all 
your applications and documents. 

Setting Default Options in Windows NT 3.51

1. Double-click the Control Panel icon in the Main group. 

2. Double-click the Printers icon. 

3. Select the EPSON Stylus COLOR 1520 printer window, if 
necessary.

4. Open the Printer menu and select Properties.

5. Click Details, then click Job Defaults. You see the Main 
printer settings dialog box.

6. Change the settings as described on page 1-2 and click OK. 
Any changes you make become the default settings for all 
your applications and documents. 

Note:
You can access the 
default Windows NT 
printer software settings 
only if you have the 
appropriate network 
access privileges, such 
as Administrator or Power 
User.
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Checking Printer Status

While your document is printing, the EPSON Despooler dialog 
box appears on your screen. (With Windows NT you don’t see 
the Despooler. See the next page for more information.)

This dialog box shows the progress of your print job and the 
status of your printer. If you run out of paper, for example, the 
Despooler warns you. 

You can use the buttons to cancel, pause, or restart your print 
job, if necessary. When the print job is finished, the Despooler 
dialog box disappears. 

If you don’t want the 
Despooler dialog box to 
appear each time you 
print, you can turn it off. 
To do this, start Spool 
Manager, open the View 
menu, and select Show 
Despool Popup; the 
checkmark next to the 
option disappears.

The name of 
the file you’re 
printing appears 
here

Click to 
pause 
printing

Click to 
cancel 
printing

Click to 
restart printing

Windows 95 
only
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The Status Monitor at the bottom of the dialog box shows how 
much ink is left in your printer, along with these status icons:

Checking Printer Status with Windows NT

With Windows NT 4.0 servers and workstations, the messenger 
service alerts you to printer errors or lets you know when a print 
job is finished. If you have appropriate network access privileges 
or you’re controlling printing from the server, you can also 
cancel, pause, or restart print jobs and set the sharing, security, 
scheduling, and port options. See your Windows NT 4.0 
documentation for details.

You can check the status of your print job in 
Windows NT 3.51 using the Print Manager. Options in the 
Print Manager window let you pause, resume, or delete print 
jobs and handle the print queues on your system, depending on 
your network access privileges. See your Windows NT 3.51 
documentation for instructions. 

Note:
The Status Monitor 
appears only if you’re 
using Windows 95 and 
you’re not printing over 
a network.

Checking the printer status.

A printing error has occurred and your printer 
cannot print. Check your printer or see Chapter 7 
for troubleshooting information.

The printer is ready to print.

The printer is currently printing.

The ink level is low or empty; check the Ink Out B 
or Ink Out A light on the control panel and 
replace the cartridge if necessary.
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Printing from a Macintosh
When you print with a Macintosh, you need to check the 
printer software settings for each application you use. This 
section describes the settings you’ll need to choose for all your 
everyday printouts. See Chapter 2 for information about 
advanced settings for special print jobs. 

1. Start the application you want to print from and create a 
document.

2. Choose Page Setup from the File menu. You see the Page 
Setup dialog box:

3. First choose your paper feeding source. The default Paper 
Source is Auto Sheet Feeder, for the built-in sheet feeder 
at the front of your printer. (For instructions on printing 
with the other feeders, see Chapter 3.)

4. After selecting your paper source, choose the Paper Size 
setting, orientation, reduction or enlargement, and 
printable area. (Your software application may let you 
control some of these settings.)

5. Click OK to close the Page Setup dialog box and continue.

6. Choose Print from the File menu or click the print icon in 
your application. 

Click to select your 
paper source

Click to select your 
paper size

Note:
Whenever you change 
the Paper Source, Paper 
Size, or Orientation 
settings, check the printer 
illustration in the dialog 
box to see how your 
document will print.

If you load your paper 
long edge first, select a 
landscape paper size, 
such as Letter 
(Landscape), and then 
select your print 
orientation so the printer 
knows which way you 
loaded the paper.

Keep in mind that some 
application software may 
have paper size and 
orientation settings that 
override your printer 
software settings.

To cancel your changes 
and exit the software, 
click the Cancel button at 
any time.
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You see a dialog box like the following:

7. Choose the number of copies and indicate which pages you 
want to print.

8. Make sure the Mode option is set to Automatic so the 
printer software can determine the best settings according 
to the Media Type and Ink settings you make. This is the 
easiest way to get good printing results for all kinds of 
documents, on all types of paper.

9. Choose the Media Type you want to print on from the 
following list. If you are not sure which setting to select, 
refer to the table on page 3-3.

◗ Plain Paper

◗ 360 dpi Ink Jet Paper

◗ Photo Quality Ink Jet Paper

◗ Photo Quality Glossy Paper

◗ Photo Quality Glossy Film

◗ Ink Jet Transparencies

◗ Ink Jet Back Light Film

◗ Ink Jet Canvas Cloth

The type of media you choose determines the Print 
Quality setting (resolution) you can use. 

Click for more information 
about printer settings

Click to select your media type

For printing at the highest 
resolution (SuperFine 
quality at 1440 dpi), you 
need to use one of the 
photo quality media, back 
light film, or canvas cloth. 
For the best printing at any 
resolution, always use 
EPSON media.
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10. Choose Color or Black ink. If you are printing black text 
or a draft, or if you want colors to print as varying shades of 
gray, choose Black for faster printing.

11. Set the slider to Quality or Speed. This lets you choose 
between high resolution printing or faster printing on the 
media you’re using. (The slider is not available for certain 
media types and may not set the highest available 
resolution.)

Once you’ve changed these basic settings, check the 
Current Settings box on the right side of the menu to see if 
the other settings are correct for your document. If you 
need to adjust them, use Advanced mode as described in 
Chapter 2.

12. Click Print when you’re finished checking your settings. 

If you chose background printing when you set up your 
printer, you can continue working while your document is 
printing. See “Using EPSON Monitor2” in Chapter 4.

Using Online Help
For complete information about using the printer software, you 
can easily access online help any time. 

Accessing Help from Windows Applications

To access online help from your application, open the File 
menu and choose Print or Print Setup. Then click Printer, 
Setup, Options, or Properties; you may need to click a series 
of these buttons, depending on the software you’re using. Click 
the Help button at the bottom of the dialog box for help related 
to the items on that dialog box. Then select a help topic.

You can also access online help when you’re not using the 
software, as described below.

Note:
On the Macintosh, printer 
settings are saved with 
your document, but you 
can’t save them from one 
application to another. 
You’ll have to check your 
settings each time you 
print from a new 
application. If you want to 
reuse settings, you can 
create document 
templates for your 
favorite applications.

A Power Macintosh 
Extension module called 
EPSON Stylus 
PowerPlug was installed 
and enabled when you 
installed your Macintosh 
printer software. This 
extension accelerates 
the rendering and 
processing of all 
documents when you’re 
using a Power Macintosh.
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Accessing Help from Windows 95

Click the Start button, point to Programs, and Epson, and 
then click EPSON Stylus COLOR 1520 Help. For instructions 
on using help, read the online “Quick Guide to Using Help.”

Accessing Help from Windows 3.1 

In Program Manager, open the EPSON group and click the 
EPSON Stylus COLOR 1520 Help icon. For instructions on 
using help, read the online “Quick Guide to Using Help.”

Accessing Help from Windows NT 4.0

Click the My Computer icon, then click the Printers icon. 
Right-click the EPSON Stylus COLOR 1520 icon and select 
Document Defaults from the menu. In the printer software 
dialog box, click the Help button. For instructions on using 
help, read the online “Quick Guide to Using Help.”

Accessing Help from Windows NT 3.51

Double-click the Control Panel icon in the Main group. Then 
double-click the Printers icon. Select the EPSON Stylus 
COLOR 1520 printer window, then open the Printer menu and 
select Properties. Click Details, then click Job Defaults. In 
the printer software dialog box, click the Help button. For 
instructions on using help, read the online “Quick Guide to 
Using Help.”

Accessing Help from Macintosh Applications

Choose Print from the File menu or click the print icon in your 
application. Click the Help button for help related to the items 
on that menu. To exit Help, click the OK button at the bottom 
of the Help screen.

With Windows 95 and 
Windows NT you can get 
specific help related to 
any item in the menus by 
right-clicking the item 
and then clicking the 
What’s This? prompt.
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What To Do When the Printer 
Lights Come On 

The lights on your printer’s control panel show the printer’s 
status and alert you to problems, such as paper jams or low ink. 

color Ink Out 
light

black Ink Out 
light

Paper Out 
light

Operate The Operate light is on when the printer is on. When the 
Operate light flashes, the printer is receiving data. It may also 
flash with other lights during other operations or error 
conditions.

Paper Out S When the Paper Out light comes on, your paper ran out or is 
loaded incorrectly, or the paper release lever is set to the wrong 
position. Load paper, check the lever position (as described on 
page 3-6), and then press the Load/Eject button to turn off 
the light. If the Pause light is on, press the Pause button to 
turn it off.

When the Paper Out light flashes, you have a paper jam. Turn 
off the printer and gently pull out all jammed paper. Reload 
the paper, then press the Load/Eject button to turn off the 
light. If the Pause light is on, press the Pause button to turn 
it off. (See Chapter 7 for more information.)

Operate light

Cover Open 
light

Pause light
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Ink Out B

Ink Out A

When an Ink Out light flashes, your ink supply is low. Make 
sure you have a replacement cartridge.

When an Ink Out light comes on, you need to replace the ink 
cartridge. See Chapter 6 for instructions.

Pause When the Pause light is on, printing is paused. Press the 
Pause button to resume.

When the Pause light flashes, your printer is charging ink, 
cleaning the print heads, or performing another operation. See 
Chapter 6 for details. 

If you need to reset the printer’s memory, hold down the 
Pause button for 5 seconds.

Cover Open When the Cover Open light comes on, the printer’s cover is 
open and printing is paused. Close the cover. If the Pause 
light is on, press the Pause button to turn it off and resume 
printing.

All the lights When all the lights flash, your printer may have an internal 
error. See Chapter 7 for more information. 
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2
When you want to print presentation graphics, photographs, or 
other special projects, you can use the custom settings in your 
EPSON Stylus COLOR 1520 software. You can choose 
predefined settings or adjust individual options like brightness, 
contrast, saturation, and halftoning. For professional-quality 
color accuracy, you can use Image Color Matching (ICM) with 
Windows 95 or ColorSync on the Macintosh.

This chapter includes the following information:

◗ Using predefined advanced settings

◗ Customizing print quality and special effects

◗ Customizing color settings

◗ Using ColorSync on the Macintosh

◗ Saving custom settings

Using Predefined Advanced 
Settings
Predefined settings provide an easy way to fine-tune your 
printer’s operation for special projects. Follow these steps to 
print with predefined settings:

1. Create your document, image, or project in your 
application software.

Custom Printing

Note:
For instructions on 
printing HPGL or 
HPGL/2 plot files, see 
Appendix B.
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2. Access the Main printer settings dialog box as described on 
page 1-2 (Windows) or page 1-9 (Macintosh).

You see one of the following dialog boxes:

3. Select Color or Black Ink.

Note:
When you use advanced 
settings, the 
Quality/Speed slider 
disappears.

Click Advanced, then click here 
to see a list of project types

Macintosh Click Advanced, then click here 
to see a list of project types

Windows
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4. Click Advanced, and then Custom Settings. You see a 
list of project types.

5. Follow these guidelines to choose the right setting for your 
project:

◗ Photo
For printing scanned photographs. Increases contrast 
in the image.

◗ Text/Graph
For printing graphics-intensive documents like 
presentation pages with charts and graphs. Intensifies 
colors and lightens the midtones and highlights.

◗ Video/Digital Camera (not available with 
Windows NT)
For images captured from a digital camera or video. 
Increases color brightness and makes the image sharper.

◗ Economy
For rough drafts of text only, on plain paper. Saves ink. 

◗ ICM (Windows 95 only)
Automatically adjusts printout colors to closely match 
the colors on your screen. 

◗ ColorSync (Macintosh only)
Automatically adjusts printout colors to closely match 
the colors on your screen. For more information, see 
page 2-10.

6. Choose the Media Type you want to print on. (If you are 
not sure which setting to select, refer to the table on 
page 3-3.) The available media may be limited by the 
project you choose. 

7. Select the correct Paper Source, Paper Size, and other 
options for the media and feeder you’re using. See page 1-3 
(Windows) or page 1-9 (Macintosh) for instructions.

Note:
Always choose your Ink 
setting before you select a 
project setting from the 
Customs Settings list.

Selecting Video/Digital 
Camera, ICM, or 
ColorSync automatically 
sets the Ink option to 
Color.

Note:
See Chapter 3 for 
information about using 
special media.
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8. Check the Current Settings box on the bottom of the menu 
to see if the other settings are correct for your document. 
If they’re correct, click OK or Print. (If you’re using 
Windows, click any other buttons that your application 
uses for printing.)

If the predefined settings are not quite what you want, 
follow the steps in the next section to change them.

Customizing Print Quality and 
Special Effects
If you need maximum control over your project, or you want to 
experiment with special effects, you can adjust individual 
settings in your printer software. Follow these steps:

1. Create your document, image, or project in your 
application software.

2. Access the Main printer settings dialog box as described on 
page 1-2 (Windows) or page 1-9 (Macintosh). 

3. Click Advanced, and then click More Settings. You see 
the More Settings dialog box:

Note:
If you’re printing with 
WIndows NT 3.51, 
follow the steps in the 
next section to check an 
additional print option 
described on page 2-7.

Note:
After you customize your 
print settings for a special 
project, you can save 
them as a group. Then 
you can reuse them 
whenever you print a 
similar project. See 
page 2-11 for instructions.

Windows

Some of these options 
are automatically set or 
disabled by other settings 
you choose
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4. Choose one of the following Print Quality options:

◗ Economy
For low-resolution rough drafts on plain paper. 
Saves ink.

◗ Normal - 360 dpi
For most documents on plain paper, transparencies, or 
360 dpi Ink Jet or Banner paper.

◗ Fine - 720 dpi
For high-resolution output. Works best on photo 
quality media, back light film, or canvas cloth.

◗ SuperFine - 1440 dpi
For the highest-resolution output on photo quality 
media, back light film, or canvas cloth only.

5. Choose the Media Type setting you want to use, following 
the guidelines on page 3-3. 

6. Select Color or Black ink.

Macintosh

Note:
The Print Quality is 
selected automatically 
depending on the current 
Media Type. If you choose 
a Print Quality setting that 
is not appropriate for your 
media, the driver changes 
the Media Type setting. 
Be sure to check both of 
these settings to make 
sure they are correct for 
the media you loaded.

Some of these options 
are automatically set 
or disabled by other 
settings you choose
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7. Choose one of the following Halftoning options:

◗ No Halftoning
For printing black text only.

◗ Error Diffusion
For printing photographic or video/digital camera 
images. Blends each dot of color with the surrounding 
dots.

◗ Fine Dithering, Coarse Dithering
For printing charts, graphs, and other images that 
require precise, solid areas of bright colors. Arranges 
dots in orderly patterns. Use Coarse for images with 
more shading and less detail. Use Fine for images with 
more detail and less shading.

8. Choose any of the following print options. Some of these 
settings are automatically selected or disabled by the Print 
Quality (resolution) and Media Type settings you chose.

◗ MicroWeave
For improved print quality. Prints graphic data in finer 
increments to eliminate unwanted banding effects 
(light horizontal lines). Always use for color printing.

◗ High Speed
For fast, bidirectional printing at lower quality.

◗ Flip Horizontal
Prints a mirror image of your document. Use for 
printing with iron-on transfer paper or back light film 
so the image will appear correctly on your iron-on item 
or backlit display.

◗ Finest Detail
For printing text, graphics, and line art with very sharp 
edges. Slows print speed and increases your system 
memory requirements. 

Note:
In Automatic mode, the 
Halftoning setting is 
selected based on the 
data in your print job. In 
Advanced mode, 
Halftoning is preselected 
for each document type 
setting. The No Halftoning 
option is available only 
when you select Black as 
the Ink setting.

If vertical lines in your 
printout are misaligned 
when you use the High 
Speed setting, you may 
need to align the print 
heads. See Chapter 6 for 
instructions.
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◗ Print Using a Temporary File (Windows NT 3.51 
only)
For increasing the speed that Windows NT 3.51 
returns to your application by printing to a temporary 
print file. A separate application then sends the file to 
your printer. Turn this option off when printing 
complex documents or if parts of a printout are missing 
after printing with it turned on.

9. If you’re ready to print, click OK and go to step 10. If you 
want to adjust your printer’s color settings, see the next 
section.

10. Click Save Settings if you want to save your custom 
settings as a group that you can reuse for special projects. 
See page 2-11 for instructions.

11. Click OK (Windows) or Print (Macintosh). If you’re using 
Windows, click any other buttons that your application 
uses for printing.

Customizing Color Settings
You can choose from several color adjustment modes or 
manually adjust brightness, contrast, saturation, and individual 
CMY (cyan, magenta, yellow) colors. For improved color 
accuracy, you can use Image Color Matching (ICM) under 
Windows 95 or ColorSync on the Macintosh.
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Follow these steps to customize your color settings:

1. Access the More Settings dialog box as described on 
page 2-4. The color settings appear on the right side of the 
dialog box, as shown:

2. Choose one of the following Color Adjustment Modes or 
choose another mode, as described in step 4:

◗ Automatic
Analyzes the color information in your project and 
optimizes color correction accordingly.

◗ Photo-realistic
For printing color photographs. 

◗ Vivid
For printing graphics-intensive documents like 
presentation pages with charts and graphs. Intensifies 
colors and lightens the midtones and highlights.

Click to set Color Adjustment Mode

Drag sliders to 
set values 
between -25% 
and +25%

Macintosh

Windows 
(ICM is available only for Windows 95)
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◗ No Color Adjustment (Windows NT 4.0 and 
Macintosh only)
With Windows NT 4.0, disables the color adjustment 
features of the printer software so you can adjust colors 
using your application. On a Macintosh, choose this 
mode only if you’re using ColorSync.

3. If you want to change individual color characteristics, use 
the scroll bars to increase (drag right) or decrease (drag left) 
the settings listed below. (If you use one of the options 
described in step 4, you won’t be able to specify individual 
color characteristics.)

◗ Brightness
Makes your image lighter or darker.

◗ Contrast
Increases or decreases the difference between the bright 
or dark parts of an image.

◗ Saturation
Makes colors more vivid or less vivid.

◗ Cyan, Magenta, Yellow
Increases or decreases the amount of the three ink 
colors that combine to make a full-color picture. Use to 
fine-tune the color balance in your printout.

4. To fine-tune color correction for video/digital images or to 
closely match screen colors, choose one of these modes 
instead of a Color Adjustment Mode:

◗ Video/Digital Camera (not available with 
Windows NT)
Use for printing images captured from a digital camera 
or video. Increases contrast and saturation and makes 
the image sharper.

◗ ICM (Windows 95 only)
Automatically adjusts printout colors to closely match 
colors on the screen. 

Note:
When you choose 
Video/Digital Camera, 
ICM, or ColorSync, the 
individual color 
characteristics described 
in step 3 are preset.

The availability of ICM 
depends on your Print 
Quality, Media Type, and 
Halftoning settings.
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◗ ColorSync (Macintosh only)
Automatically adjusts printout colors to closely match 
colors on the screen. See “Using ColorSync on the 
Macintosh” below for instructions.

5. Click OK to return to the Main printer settings dialog box.

6. Click Save Settings if you want to save your custom 
settings as a group that you can reuse for special projects. 
See page 2-11 for instructions.

7. Click OK (Windows) or Print (Macintosh). If you’re using 
Windows, click any other buttons that your application 
uses for printing.

Using ColorSync on the Macintosh
Every device you use for viewing or producing colors—your 
monitor, scanner, and printer—uses a different color 
technology. That’s why it’s difficult to get printed colors to 
match the colors displayed on your monitor. 

Each device has its own gamut, or range of colors, that it can 
reproduce. The Macintosh ColorSync system translates colors 
from one gamut to another so your monitor’s colors match your 
printer’s colors as closely as possible. 

ColorSync uses profile information from each device—
including your EPSON Stylus COLOR 1520—to achieve 
accurate color matching. First you set your monitor’s profile. 
Then you can use your printer software to specify the exact 
method of “gamut mapping” (color matching) you want to use. 
Follow these steps:

1. Open ColorSync System Profile under Control Panels 
on the Apple menu.

2. Click the Set Profile button.

3. Select your monitor from the list, and then click Select.
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4. Close ColorSync System Profile.

5. Open the application you want to print from.

6. Access the printing dialog box as described on page 1-9. 
Click Advanced and then click More Settings.

7. Click ColorSync on the right side of the dialog box.

8. For Profile, choose EPSON Standard.

9. Choose one of the following options for Rendering Intent:

◗ Perceptual
For printing photographs. Adjusts the colors displayed 
on the monitor so they fit within the printer’s gamut, 
but maintains the relationships between colors.

◗ Saturation
For printing graphics-intensive documents like 
presentation pages with charts and graphs. Maintains 
the relative saturation of colors from one gamut to 
another.

◗ Colorimetric
For matching colors as precisely as possible. Maintains 
colors that fall within the gamuts of the monitor and 
printer, but may lose some detail where the colors are 
outside the printer’s density range.

10. Click OK, and then click Print.

Saving Custom Settings
After you’ve fine-tuned your printer settings for a special 
project, you can save them as a group with a unique name. 
Then you can select it the next time you print a similar project. 

1. Customize your printer settings as described in this chapter.

2. Click the Save Settings button on the Main printer 
settings dialog box. (If the button is grayed out, select 
Advanced.)

Note:
The EPSON Standard 
profile is custom-
designed for your printer. 
If you use a scanner or 
other color imaging 
equipment, you may have 
other profiles available.

The Saturation and 
Colorimetric options are 
only available when 
you’re using Fine - 720 dpi 
or SuperFine - 1440 dpi 
Print Quality.
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You see one of the following:

3. Type a unique name for your settings (up to 16 characters) 
and click the Save button.

The name you choose is now available on the Main printer 
settings dialog box when you click Advanced, and then 
Custom Settings.

Deleting Custom Settings

If you no longer need a customized setting, follow these steps to 
delete it:

1. Select Advanced mode. 

2. Click Save Settings.

3. Select the name of your custom setting group in the 
Custom Settings box, and click Delete. (You cannot delete 
any of the predefined document types.)

Note:
You can save up to 10 
groups of settings.

If you change the Media 
Type or Ink setting when 
your customized setting is 
selected, the setting 
selected in the list 
changes to Custom 
Settings. To return to your 
customized setting, 
reselect it in the list. To 
redefine a customized 
setting, see page 2-13.

Macintosh

Windows
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Redefining Custom Settings

To change the options in a customized setting group but keep 
the same name for it, follow these steps:

1. Select Advanced mode. 

2. Select the name of the custom setting group you want to 
redefine in the Custom Settings list.

3. Change the printer settings as necessary. (If you change the 
Media Type and Ink setting, the custom setting group 
name disappears from the list momentarily.)

4. Click Save Settings.

5. Select the name of the custom setting group you’re 
redefining in the Custom Settings box.

6. If you’re using Windows, click Save. You see the Save As 
dialog box. Click OK to save your redefined settings. (Click 
Cancel to cancel your changes.)

On a Macintosh, click the Redefine button. Then click 
Replace at the confirmation dialog box to save your 
redefined settings. (Click Cancel to cancel your changes.)
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3
Your EPSON Stylus COLOR 1520 lets you print on just about 
any kind of paper you want to use. You can get great results 
printing on plain paper, letterhead, and envelopes. But you’ll 
get the best results with EPSON’s specially coated ink jet paper. 
You can choose from a variety of EPSON media, ranging from 
glossy paper and transparencies to iron-on transfer paper and 
canvas cloth. 

Your printer’s versatile feeding options let you load media of 
almost any size or format, including single sheets, continuous 
paper, and roll paper for banners and signs. You can even load 
two types of paper at once, switching between them with the 
flip of a lever when you’re ready to print on them.

This chapter covers the following:

◗ Using special media types

◗ Printing on single sheets

◗ Printing on continuous paper

◗ Adjusting the loading and tear-off positions

◗ Switching between continuous and single-sheet paper

◗ Printing a banner or other roll paper project

◗ Printing a backlit display

Printing on
Special Media
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Using Special Media Types
The type of paper or other media you use can help determine 
the ultimate quality of your printed output. You can achieve 
good results with plain paper, but for better results, use EPSON 
media for EPSON ink jet printers because they provide the best 
surface for the ink used in your printer. 

EPSON ink jet paper comes in a variety of types and sizes. To 
order, contact your dealer or call EPSON Accessories at 
(800) 873-7766 (U.S. sales only). In Canada, please call 
(800) 873-7766 for dealer referral. 

Media name Size Part number

EPSON 360 dpi Ink Jet Paper Letter
A4
Super A3/B

S041060
S041059
S041066

EPSON High Quality Ink Jet Paper Letter
A4

S041111
S041117

EPSON Photo Quality Ink Jet Paper Letter
A4
Legal
B
Super A3/B
A2

S041062
S041061
S041067, S041048
S041070
S041069
S041079

EPSON Photo Quality Glossy Paper A4
Letter
A2
Super A3/B

S041126
S041124
S041123
S041133

EPSON Photo Quality Glossy Film A4
Letter
A6
B
Super A3/B

S041071
S041072
S041107
S041075
S041074

EPSON Ink Jet Transparencies A4
Letter

S041063
S041064

EPSON Photo Quality Ink Jet Cards A6
8 × 10

S041054
S041122

EPSON Iron-On Transfer Paper Letter
Super A3/B

SE41001, SE41002
SE41003
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Media Loading and Software Setting 
Guidelines

Whether you print on plain paper or special media, you need to 
load it according to the guidelines in the table below. You must 
also select the correct Media Type setting in your printer 
software to match the media you loaded. Also check the media 
loading guidelines following the table for more information.

EPSON Photo Quality Self Adhesive Sheets A4 S041106

EPSON Photo Quality Banner Paper A2 × 15 m roll
16.5 inches × 49 ft

S041102

EPSON Ink Jet Canvas Cloth A2 × 3 m roll
16.5 inches × 9.8 ft

S041132

EPSON Ink Jet Back Light Film A3
A2

S041131
S041130

Media name Size Part number

When you load media with this 

name . . .

Load a maximum of this 

many sheets in the 

built-in sheet feeder as 

described on page 3-6 . . .

Then select this Media 

Type setting in your printer 

software . . .

Plain paper (single sheets) 100 letter size
30 Super A3/B size
30 A2 size 

Plain paper

Continuous paper (plain or labels) See “Printing on 
Continuous Paper” on 
page 3-14.   

Envelopes1 10

EPSON 360 dpi Ink Jet Paper 70 letter size
30 legal size
30 Super A3/B size
30 A2 size

360 dpi Ink Jet Paper

EPSON Special Coated Paper for 
360 dpi Printing

EPSON High Quality Ink Jet Paper 70 letter size
30 legal size
30 Super A3/B
30 A2 size

Photo Quality Ink Jet Paper

EPSON Photo Quality Ink Jet Paper

EPSON Special Coated Paper for 
720 dpi Printing
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1 If you’re printing from DOS, see Chapter 5 for printing instructions.
2 With multiple sheets loaded, the minimum top margin is 1.2 inches (30 mm). For a smaller top 

margin or for ease in loading, load and print one sheet at a time with a support sheet beneath it.
3 Turn on the Flip Horizontal option to reverse your image before you print it—especially if it 

includes text—so the image will appear correctly when it’s transferred. See Chapter 2 for 
instructions. After you print, follow the instructions that came with the paper to iron the image 
onto the shirt or other item.

EPSON Photo Quality Ink Jet Cards 30 cards1 Photo Quality Ink Jet Paper

EPSON 720 dpi Index Cards 

EPSON Photo Quality Self Adhesive 
Sheets

See “Loading Paper in the 
Manual Feeder” on 
page 3-11.

EPSON Photo Quality Banner Paper See “Loading Roll Paper” 
on page 3-22.   

EPSON Photo Quality Glossy Paper 
(use with support sheet)

20 sheets Photo Quality Glossy Paper

EPSON Photo Quality Glossy Film 
(use with support sheet)

30 letter size2

1 A2 size
Photo Quality Glossy Film

EPSON High Quality Glossy Paper 
(use with support sheet)

30 letter size2

1 A2 size

EPSON Iron-On Transfer Paper3 1 sheet

EPSON Ink Jet Transparencies (use 
with support sheet)

30 sheets Ink Jet Transparencies

EPSON Ink Jet Back Light Film See “Loading Back Light 
Film” on page 3-33.   

Ink Jet Back Light Film

EPSON Ink Jet Canvas Cloth See “Loading Roll Paper” 
on page 3-22.   

Ink Jet Canvas Cloth

When you load media with this 

name . . .

Load a maximum of this 

many sheets in the 

built-in sheet feeder as 

described on page 3-6 . . .

Then select this Media 

Type setting in your printer 

software . . .
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Additional Media Loading Guidelines

◗ In addition to the Media Type setting, remember to select 
the correct Paper Size for your media.

◗ Some special media have a cut corner you must position 
correctly; follow any instructions in the package. Always 
handle sheets by the edges; don’t touch the printable side.

◗ Make sure labels are fully adhered to their backing sheet 
before you load them.

◗ When loading pre-printed paper, such as letterhead or 
forms, make sure the paper’s top edge leads into the printer.

◗ Use ink jet papers within one year of purchase. Use glossy 
media and transparencies within six months. Return 
unused media to their original packages as soon as possible. 
See Appendix C for more media storage information.

◗ If your special media came with a cleaning sheet, be sure to 
feed it through the printer after you’ve finished using the 
package of paper. Peel off the instruction sheet; then 
position the cut corner of the cleaning sheet in the built-in 
sheet feeder as shown below. Press the Load/Eject button 
to feed it through the printer. Repeat this several times.

◗ See these sections for complete paper loading instructions:

◗ See page 3-6 for sheet feeder instructions.

◗ See page 3-11 for manual feeder instructions.

◗ See page 3-14 for tractor feeder instructions.

◗ See page 3-22 for roll feeder instructions.

Note:
If you don’t see the 
Media Type option for 
your paper when you’re 
using the printer 
software, change the 
Print Quality setting in 
the More Settings dialog 
box, select Automatic as 
the Mode setting, or 
change the predefined 
setting in the Custom 
Settings list on the Main 
menu. See Chapter 2 for 
instructions on selecting 
these settings.

Be sure to feed a 
cleaning sheet through 
the printer after using 
any package of special 
media that comes with 
the cleaning sheet so 
you don’t experience 
feeding problems.

cut corner
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Printing on Single Sheets
You can print on single sheets of paper up to 17 inches wide 
(432 mm) in your printer using the built-in sheet feeder or the 
manual feeder.

You’ll probably use the built-in sheet feeder at the front of your 
printer for the size paper you use most often, such as letter- or 
legal-size sheets. Then you can use the manual feeder at the top 
of the printer for loading individual, large format sheets or roll 
paper using the optional Banner Paper Kit. (See page 3-22 for 
more information on the Banner Paper Kit.) 

Follow the instructions in the sections below to load single 
sheets of paper from these feeders.

Loading Paper in the Built-in Sheet Feeder

You can load paper up to 17 inches wide (432 mm) in the 
built-in sheet feeder, but do not load the stack above the arrow 
mark on the right edge guide. Load legal-size or larger paper no 
more than halfway to the arrow mark.

If you load paper more than 14.3 inches (364 mm) wide, load a 
maximum of 30 sheets at a time, regardless of the paper type.

1. Turn on the printer, but don’t send a print job before you 
load paper in the sheet feeder; always load paper first.

2. Set the paper release lever to the single sheet position (the 
single sheet icon appears beneath the lever handle).

Note:
The maximum printable 
width is 13.6 inches 
(345 mm) on any size 
paper.

single sheet icon

media.fm5  Page 6  Friday, May 9, 1997  1:48 PM



Printing on Special Media

3-7

3. Open the printer cover and set the thickness lever to the 0 
position when you print on plain paper, ink jet paper, 
transparencies, or transfer paper.

Set it to the + position when you print on envelopes, ink jet 
cards, or heavy paper.

4. Lock the output tray in an upright position on the two 
upper posts.

5. If you’ll be printing on paper that is 14.3 inches (364 mm) 
wide or less, slide the right edge guide all the way left until 
it stops.

0 position

+ position
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If the paper is more than 14.3 inches (364 mm) wide, slide 
the right edge guide all the way right.

6. Slide the left edge guide to match the approximate width of 
your paper. Then move the center support midway 
between the two edge guides.

7. Pull out the rear paper support guide until it stops.

8. Fan your stack of paper and then even the edges.

center support

left edge guide
right edge guide
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9. Load a stack of paper with the printable side face down and 
slide it all the way into the feeder. Gently press the stack 
against the right edge guide. Then slide the left edge guide 
against the left side of the paper.

If you’re loading paper that does not reach to the end of the 
rear paper support guide, slide the guide up against the edge 
of the paper. If your paper is long, let it lay over the edge of 
the paper support.

To load up to 10 envelopes, place them face down with the 
flap edge leading into the feeder. Then slide the left edge 
guide and the rear paper support guide against the edges of 
the envelopes.

For C5-size envelopes, remove the rear paper support guide 
and reinstall it backward, sliding it up to the edge of the 
envelopes.

rear paper 
support guide
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To load up to 30 ink jet cards, place them printable side 
down, with the short edge leading into the feeder. Remove 
the rear paper support guide and reinstall it backward, 
sliding it forward to the edge of the cards.

10. Lower the output tray and slide out the output tray 
extension.

11. Now follow the instructions in Chapters 1 or 2 to select the 
correct Paper Source, Paper Size, and other settings in 
your printer software. Then send a print job.

◗ If you run out of paper while printing, reload the sheet 
feeder and press the Pause button to continue.

◗ If the ink smears on your document, set the thickness 
lever to the + position and reprint; see page 3-7.

◗ If your margins are not where you like them, adjust 
them in your application software. However, if the 
problem seems to be with your paper’s loading 
position, you can change it using the Micro Adjust 
buttons; see page 3-20 for instructions.

rear paper 
support guide

Note:
Make sure that paper 
isn’t loaded in the manual 
feeder at the top of the 
printer before sending 
your print job. If paper is 
loaded in the manual 
feeder, the printer will 
print on it instead of the 
paper in the built-in sheet 
feeder.
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Loading Paper in the Manual Feeder

You can load one single sheet of paper in the manual feeder 
without removing paper from the built-in sheet feeder. Load 
any type of paper that is between 4.1 inches (105 mm) and 
17 inches (432 mm) wide. 

1. Turn on the printer, but don’t send a print job before you 
load paper in the manual feeder; always load paper first.

2. Set the paper release lever to the single sheet position (the 
single sheet icon appears beneath the lever handle).

3. Open the printer cover and set the thickness lever to the 0 
position when you print on plain paper, ink jet paper, 
transparencies, transfer paper, or labels.

Set it to the + position when you print on envelopes, ink jet 
cards, or heavy paper.

Note:
To load banner paper, 
canvas cloth, or other roll 
paper in the manual 
feeder, you must also use 
the optional Banner Paper 
Kit. See page 3-22 for 
instructions.

single sheet icon

0 position

+ position
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4. If any paper is currently loaded in the paper path from the 
built-in sheet feeder or the tractor feeder, press the 
Load/Eject button to eject the paper or park it out of the 
way.

5. If you’ll be printing on paper that is 14.3 inches (364 mm) 
wide or less, slide the right edge guide on the manual feeder 
so its right edge aligns with the arrow mark on the manual 
feed guide.

If the paper is more than 14.3 inches (364 mm) wide, slide 
the right edge guide all the way right.

6. Slide the left edge guide to the width of your paper. Then 
load the paper with the printable side face up and its right 
edge against the right edge guide. Gently slide the paper 
into the manual feeder until the printer pulls it in. 

arrow
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You can load one envelope in the manual feeder face up 
with the flap edge leading into the feeder. Gently slide the 
envelope into the manual feeder until the printer pulls it in.

If the paper doesn’t load straight, press the Load/Eject 
button to eject the paper; then load it again.

7. Now follow the instructions in Chapters 1 or 2 to select the 
correct Paper Source, Paper Size, and other printer 
software settings. Then send a one-page print job.

8. When your print job is finished, the Pause and Paper Out 
lights come on. Press the Pause button to turn off the 
lights.

◗ If you want to print another document in the manual 
feeder, load the paper as described above. To print on 
paper in the built-in sheet feeder, just send a print job.

◗ If the ink smears on your document, set the thickness 
lever to the + position and reprint; see page 3-7.

◗ If your margins are not where you like them, adjust 
them in your application software. However, if the 
problem seems to be with your paper’s loading 
position, you can change it using the Micro Adjust 
buttons; see page 3-20 for instructions.

arrow

Note:
Make sure that paper 
isn’t loaded in the manual 
feeder at the top of the 
printer before sending a 
print job for paper in the 
built-in sheet feeder. If 
paper is loaded in the 
manual feeder, the 
printer will print on it 
instead of the paper in 
the built-in sheet feeder.
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Printing on Continuous Paper
You can load continuous paper in the built-in tractor feeder on 
the back of the printer without removing paper from the 
built-in sheet feeder. Load any type of continuous paper that is 
between 4 inches (102 mm) and 16 inches (406 mm) wide, 
such as greenbar paper, fanfold banner paper, or continuous 
label paper. 

1. Turn on the printer, but don’t send a print job before you 
load paper on the tractor feeder; always load paper first.

2. Set up your printer so there’s enough room in the back to 
feed the paper and enough room in front for the printed 
pages to stack without obstruction. Position the paper 
supply within 3 feet (1 meter) of the printer.

3. Set the paper release lever to the continuous paper position 
(the continuous paper icon appears above the lever handle).

When you print on 
continuous paper, it’s a 
good idea to turn on auto 
tear-off mode so the 
printed paper can 
advance to the tear-off 
position automatically. 
Follow the instructions on 
page 5-3.

Caution:
If you load continuous 
label paper, make sure 
the printer’s auto tear-off 
feature is turned off. If 
you have this feature 
turned on, labels could 
be fed backward and 
peel off inside the 
printer. See page 5-3 for 
instructions on checking 
or changing the setting 
using default-setting 
mode. 

continuous paper icon
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4. Make sure the thickness lever is in the 0 position; see 
page 3-11 for instructions.

5. Remove the manual feeder from the top of the printer by 
pulling it straight back. Then set it aside.

6. Install the cable cover by inserting the three posts on the 
cover into the three holes on the back of the printer. Press 
the cover down until it locks in place.

To hold the printer cables away from your paper supply, 
loop them into the hooks underneath the cable cover.

7. Pull up the sprocket-lock levers to unlock them so you can 
slide the sprockets into position.

8. Slide the left sprocket all the way right until it stops. Press 
down the sprocket-lock lever to lock it in place.

sprocket-lock levers

center support
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9. Slide the right sprocket to the approximate width of your 
paper. Then position the center support midway between 
the two sprockets, as shown in the previous illustration.

10. Flip open both sprocket covers.

11. Arrange the continuous paper stack so the printable side is 
face up. Fit the first four holes over the sprocket pins on 
both sprockets; then close the sprocket covers.

12. Slide the right sprocket to remove any slack in the paper. 
Then press down the sprocket-lock lever to lock it in place.

If necessary, align your stack of continuous paper so it will 
feed straight into the tractor feeder.

Note:
The maximum printable 
width is 13.6 inches 
(345 mm) on any size 
paper.

sprocket covers
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13. Reinstall the manual feeder on the top of the printer.

14. Slide out the output tray extension. Then make sure the 
edge of the rear paper support guide is beneath the 
extension so the continuous paper doesn’t catch on it as it 
ejects.

15. Follow the instructions in Chapters 1 or 2 as necessary to 
send a print job. Be sure to select Tractor Feeder as the 
Paper Source option and then choose the correct Paper 
Size. The continuous paper loads and printing begins 
when the printer receives the print job.

Follow the steps in the next section to remove continuous paper 
correctly.

rear paper support 
guide

output tray extension

Note:
If you run out of 
continuous paper while 
printing, the Paper Out S 
and Pause lights come 
on. Load more paper on 
the tractor feeder and 
press the Pause button to 
continue printing.
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Removing Continuous Paper

When you’ve finished printing a continuous paper document, 
you must carefully follow these steps to remove it from the 
printer, depending on your media type and the setting of the 
auto tear-off feature. 

1. If the printer’s auto tear-off feature is turned on, your 
continuous paper is automatically advanced to the tear-off 
position at the end of a print job. Go to step 2. 

If the auto tear-off feature is turned off (the default setting), 
press the LF/FF button as many times as necessary to 
advance the last printed sheet to the tear-off edge. Go to 
step 2.

If the auto tear-off feature is turned off (the default setting) 
and you’re printing labels, tear off the next sheet of labels at 
the back of the printer. Then press the LF/FF button on the 
printer’s control panel as many times as necessary to eject 
the remaining pages forward out of the printer. Do not 
perform steps 2 and 3.

Note:
See Chapter 5 for 
information on using 
default-setting mode to 
change the auto tear-off 
setting for your print job.
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2. Tear off the printed pages at the perforation by pulling it 
across the tear-off edge.

If the paper’s perforation isn’t at the printer’s tear-off edge, 
adjust the tear-off position as described on page 3-21. Do 
not perform step 3.

3. Press the Load/Eject button to feed the rest of the 
continuous paper backward to the paper-park position so 
it’s ready for printing the next time you need it.

If the ink smears on your document, set the thickness lever 
to the + position and reprint; see page 3-7.

If your margins are not where you want them, adjust them 
in your application software. However, if you need to 
adjust your paper’s loading position, you can change it 
using the Micro Adjust buttons. See the next section for 
instructions.

tear-off edge

Caution:
Never press Load/Eject 
when you have 
continuous label paper 
loaded in the printer. This 
would feed labels 
backward, causing them 
to peel off inside the 
printer.
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Using the Micro Adjust Buttons
The Micro Adjust U and Micro Adjust D buttons on your 
printer’s control panel allow you to make quick adjustments to 
your paper’s loading and tear-off positions. 

Adjust the paper’s loading position if you notice that printing is 
too high or low on the page and the position cannot be 
corrected in your software program. You can even set separate 
loading positions for continuous paper, manually fed paper, or 
sheet-feeder fed paper.

If you’re using continuous paper and the perforation does not 
align with the printer’s tear-off edge when you’re done printing, 
you can use these buttons to adjust the tear-off position.

Adjusting the Loading Position

Follow these steps to adjust the loading position of your paper:

1. If you have continuous and single sheet paper loaded at the 
same time, the loading position you adjust is determined by 
the setting of the paper release lever. 

For continuous paper, set it to the continuous paper 
position. For paper in the sheet feeder or the manual feeder, 
set it to the single sheet position. 

2. Press the Load/Eject button to load a sheet of paper or load 
the first continuous sheet to the top-of-form position.

3. Press the Micro Adjust U button to feed paper backward 
or the Micro Adjust D button to feed paper forward. Press 
either button as many times as necessary to adjust the 
position. When the adjustment reaches the maximum 
setting for your printer, it does not move further.

4. Follow the instructions in Chapters 1 or 2 as necessary to 
send a print job.

Caution:
Never use the knob on 
the left side of the printer 
to adjust the loading or 
tear-off positions. This 
would damage your 
printer and cause it to 
lose the top-of-form 
position.

Note:
The loading position you 
select remains in effect 
until you change it again, 
even when you turn off 
the printer.
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Adjusting the Tear-off Position

First make sure that continuous paper is loaded in the current 
tear-off position (see page 3-18 for details). Follow these steps 
to adjust the tear-off position:

1. Press the Micro Adjust U button to feed paper backward 
or the Micro Adjust D button to feed paper forward. Press 
either button as many times as necessary to align the 
perforation with the tear-off edge. When the adjustment 
reaches the maximum setting for your printer, it does not 
move further.

2. Tear off any printed pages.

3. Press the Load/Eject button to feed the rest of the 
continuous paper backward to the paper-park position so 
it’s ready for printing the next time you need it.

The tear-off position you select remains in effect until you 
change it again, even when you turn off the printer.

For instructions on setting your printer’s auto tear-off mode, see 
page 5-3.

Switching Between Continuous 
and Single-sheet Paper
When you have both continuous paper and single sheet paper 
loaded in the built-in sheet feeder, you can switch between 
paper types whenever you need to print on them. Follow these 
steps:

1. If continuous paper remains inside the printer, tear off the 
printed pages. Then press the Load/Eject button on the 
printer’s control panel to feed the paper backward to the 
paper-park position.

If single sheet paper is loaded, press the Load/Eject button 
to eject any sheets still inside the printer.

Caution:
Never adjust the tear-off 
position when you’re 
printing labels. This could 
feed labels backward, 
causing them to tear off 
inside the printer.
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2. To switch to single sheet printing, move the paper release 
lever to the single sheet position.

To switch to continuous paper printing, move the paper 
release lever to the continuous paper position.

3. Follow the instructions in Chapters 1 or 2 to change the 
Paper Source, Paper Size, and other printer software 
settings. Then send a print job. The printer loads the type 
of paper you selected when it receives the print job.

Printing a Banner or Other Roll 
Paper Project
You can use EPSON banner paper or canvas cloth to print 
strong, attractive banners or other projects up to 44 inches long. 
EPSON Ink Jet Canvas Cloth has a cloth-like texture—much 
like artist’s canvas for paintings—that gives a distinct look to 
your printed images.

First follow the instructions below to load the banner paper or 
canvas cloth from a roll using the optional Banner Paper Kit. 
(You can also print a banner on continuous computer paper. 
See page 3-14 for paper loading instructions.) Then see the 
appropriate printing instructions for your software—Windows 
or Macintosh—in the sections that follow.

Loading Roll Paper

1. Before you load roll paper, follow the instructions on 
page 5-3 to set up the printer for banner printing using 
default-setting mode. Select these options:

◗ Turn banner mode on so the printer doesn’t advance 
too much roll paper out of the printer if you press the 
LF/FF button.

◗ Turn auto tear-off mode on so the printer can advance 
the roll paper to the correct cut-off position. 

Note:
If the Pause and Paper 
Out S lights flash, you 
may have changed the 
paper release lever 
position when paper 
was still loaded. Set the 
lever back to its original 
position and press the 
Load/Eject button to 
eject or park the paper. 
Then set the lever to its 
new position.

Note:
To print on roll paper, you 
need the optional EPSON 
Banner Paper Kit 
(C81101*). Contact your 
EPSON dealer or EPSON 
Accessories at the phone 
number on page 3-2.
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When you’ve finished setting these options, turn off the 
printer to exit default-setting mode. Wait five seconds, then 
turn on the printer again before performing step 2.

2. Make sure the paper release lever is set to the single sheet 
position. (See page 3-6 for instructions.)

3. Remove the manual feeder from the back of the printer so 
you can install the banner paper holders on it.

4. Remove the edge guides from the manual feeder by pushing 
off their bottom edges from inside the manual feeder.

media.fm5  Page 23  Friday, May 9, 1997  1:50 PM



Printing on Special Media

3-24

5. Attach the banner paper holders to the front of the manual 
feeder by positioning the top edges first, then snapping 
down the bottom edges.

6. Reattach the manual feeder to the back of the printer.
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7. Clip the banner paper cutting guide onto the output tray 
posts.

8. Slide the left banner paper holder all the way to the left and 
slide the right banner paper holder approximately 1/8-inch 
(3 mm) from the far right edge.

9. Position the roll paper so it feeds into the printer as shown 
below, with the printable side face up. Then place it onto 
the right banner paper holder and slide the left holder over 
to support the roll. Align the roll paper’s edges with the 
edge guides on the holders.Caution:

Adjust the banner paper 
holders so they fit the roll 
paper snugly, but not so 
tightly that the roll can’t 
rotate. If they’re too tight, 
the paper won’t feed into 
the printer.

set to about 1/8-inch (3 mm) 
from the far right position
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10. Grasp both sides of the roll and slowly unroll the paper into 
the slot in the manual feeder.

When the roll paper is fully inserted, the printer pulls it in 
and loads it automatically. (If the paper is crooked, press 
the Load/Eject button to unload it and try again.)

11. Before you print, raise the cutting guide to an upright 
position so the roll paper feeds beneath it.

12. Follow the instructions in the next sections to print your 
banner on either a Windows computer or a Macintosh.
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Printing a Banner from Windows

Follow these steps to print a banner or other custom-size project 
from a Windows application:

1. Create the document in your word processor or other 
application software. 

2. Choose Print or Print Setup from the File menu. You see a 
printing dialog box for your application.

3. Make sure your printer is selected, and then click the 
Printer, Setup, Properties, or Options button. (You may 
have to click a series of these buttons, depending on your 
software.) You see the Main printer settings dialog box, as 
shown on page 1-2.

4. Click the Paper tab. You see a dialog box like the 
following:

5. If you’re printing on roll paper, select Manual Feed 
Slot (Banner) from the Paper Source list. Go to step 6.

If you’re printing a banner on continuous computer paper, 
select Tractor Feeder for the Paper Source. Go to step 7.

Click to select a 
paper size

Click to select a 
paper source
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6. At the end of the Paper Size list, select one of the Long 
Paper 17 × n in. options, where n is the length of your 
banner (up to 44 inches). Go to step 8.

7. At the end of the Paper Size list, choose User Defined. The 
following dialog box appears:

Type in your paper’s width in the Paper Width field and a 
length up to 44 inches for the Paper Height. (This works 
for banners using either landscape or portrait orientation.) 
Click OK. Go to step 8.

8. Choose Portrait or Landscape, depending on the 
orientation of the banner or document you created. Set the 
printable area if necessary.

9. Click the Main tab to return to the Main printer settings 
dialog box. 

10. Choose the Media Type setting that matches your banner 
paper or canvas cloth as described in the table on page 3-3. 
(For continuous computer paper, choose Plain Paper.) 

Check the rest of the printer software settings as described 
in Chapters 1 and 2. Then click OK. 

11. Click Close, OK, or Print to print your banner.

12. When it’s finished printing, follow the steps on page 3-30 
to remove your banner from the printer. To remove 
continuous paper, see page 3-18.

For banner printing, type 
any size up to 44 inches

Note:
With Windows NT, the 
User Defined Paper Size 
dialog box includes 
settings for units of 
measure, naming of the 
paper size (up to 16 
characters), and saving 
of multiple user defined 
paper sizes. For 
instructions on using 
these settings, click the 
Help button at the bottom 
of the Paper dialog box.

Some applications may 
allow you to print banners 
longer than 44 inches; 
see your application 
program documentation 
for details.
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Printing a Banner from a Macintosh

Follow these steps to print a banner or other custom-size project 
on a Macintosh:

1. Create the document in your word processor or other 
application software. 

2. Choose Page Setup from the File menu. You see a dialog 
box like the following:

3. If you’re printing on roll paper, select Manual Feed Slot 
(Banner) from the Paper Source list. 

If you’re printing a banner on continuous computer paper, 
select Tractor Feeder for the Paper Source. 

4. Click the Customize button. The following dialog box 
appears:

5. Click the New button. 

Click to define a custom paper size

Click to select 
your paper source

Click to 
create a new 
paper size

You can create up to eight 
custom paper sizes. Give 
each one a unique name 
so you’ll be able to reuse 
them by selecting them 
from the Page Size list in 
the Page Setup dialog 
box.
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6. Type a name for your custom-size paper in the New Paper 
Size box. Then type your paper’s width in the Width field 
and a length of up to 44 inches for the Height. (This works 
for banners using either landscape or portrait orientation.) 
Click OK.

7. Choose Portrait or Landscape, depending on the 
orientation of the banner or document you created. Set the 
printable area if necessary.

8. Click OK.

9. Choose Print from the File menu or click the print icon in 
your application. You see the printer settings dialog box (as 
shown on page 1-9). 

10. Choose the Media Type setting that matches your banner 
paper or canvas cloth as described in the table on page 3-3. 
(For continuous computer paper, choose Plain Paper.) 

11. Check the rest of the printer software settings as described 
in Chapters 1 and 2. Then click Print to print your banner.

12. When it’s finished printing, follow the steps in the next 
section to remove your banner from the printer. To remove 
continuous paper, see page 3-18.

Removing a Printed Banner

Follow these steps to remove a printed banner using the cutting 
guide:

1. Lower the banner paper cutting guide over the top of the 
paper.

2. If you turned auto tear-off mode on (as instructed in step 1 
on page 3-22), the printer automatically feeds the paper to 
the tear-off position when it’s finished printing. If you 
didn’t turn on auto tear-off mode, press the LF/FF button 
to advance the paper to the tear-off position.

Note:
Some applications may 
allow you to print banners 
longer than 44 inches; 
see your application 
program documentation 
for details.
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Press Micro Adjust D and Micro Adjust U buttons as 
necessary to move the end of the banner to the cut-off 
position on the banner paper cutting guide.

3. Hold down the cutting guide. Then, using a sharp knife, 
cut straight across the paper, pressing the knife against the 
inside edge of the cutting guide and on top of the metal 
strip on the output tray.

4. Remove the printed paper and raise the cutting guide to its 
upright position.

Note:
The roll paper cut-off 
position you set remains 
in effect until you 
change it again, even 
when you turn off the 
printer.

cut-off position

Warning:
Keep your hands away from 
the knife so you don’t cut 
yourself.
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5. If you want to print another roll paper project, the printer 
will feed the roll paper back to the loading position when it 
receives a new print job. Go to step 10.

If you won’t be using the roll paper again right away, 
continue with step 6.

6. Press the Load/Eject button to eject the paper backward. 

7. Using your hands, roll back the paper all the way out of the 
manual feed slot and onto the roll. When it’s completely 
out, the Pause and Paper Out S lights turn on. 

8. Press the Pause button to turn off the lights.

9. If you’ll be using the roll paper soon after printing on 
another type of paper, lower the banner paper cutting guide 
and push it onto the edge of the output tray until it clicks. 
This keeps it out of the way of the ejected paper.

If you won’t be using your roll paper for awhile, store it in 
its original packaging. See Appendix C for optimum 
storage conditions. 

You can use the banner paper holders as your edge guides 
on the manual feeder, but if you want to remove and 
reinstall the manual feeder’s original edge guides, follow 
steps 2 through 4 on page 3-23. Then reattach the manual 
feeder to the printer.
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10. Before printing on another type of paper, be sure to change 
the Paper Source, Paper Size, and Media Type settings 
in your printer software as described in Chapters 1 and 2. 

Also be sure to turn off banner mode using the 
default-setting mode instructions on page 5-3.

If you’ll be printing on continuous paper, also be sure to 
reset the paper release lever, as described on page 3-14.

Printing a Backlit Display
You can use EPSON Ink Jet Back Light Film to print crisp, 
translucent images for backlit display. Your printer software 
automatically makes a mirror image of your design so it appears 
correctly when viewed from the reverse side. Follow the steps in 
this section to load a sheet of back light film and select the 
correct printer settings for a backlit display.

Loading Back Light Film

Before loading the back light film, make sure the sheet is flat. If 
the film curls, place it between two sheets of paper and put a 
heavy object on top to flatten it. 

Load one sheet of back light film as follows:

◗ Load it in the built-in sheet feeder with the printable, 
non-glossy, white surface face down following the 
instructions on page 3-6. 

◗ Load it in the manual feeder with the printable, non-glossy, 
white surface face up following the instructions on 
page 3-11.
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Printing a Backlit Display from Windows

1. Create the document in your word processor or other 
application software. 

2. Choose Print or Print Setup from the File menu. You see a 
printing dialog box for your application.

3. Make sure your printer is selected, and then click the 
Printer, Setup, Properties, or Options button. (You may 
have to click a series of these buttons, depending on your 
software.) You see the Main printer settings dialog box, as 
shown on page 1-2.

4. Select Ink Jet Back Light Film as the Media Type setting. 
This chooses the best printer driver settings for printing on 
back light film and automatically turns on the Flip 
Horizontal feature so your image will appear correctly 
when viewed from the reverse side.

5. Check the rest of the printer software settings available on 
the Main menu as described in Chapters 1 and 2. 

6. Click the Paper tab. 

7. Choose the Paper Source you’re using, either Auto Sheet 
Feeder (for the built-in sheet feeder) or Manual Feed 
Slot (for the manual feeder).

8. Then select the size of your back light film as the 
Paper Size setting. 

9. Click OK to save your settings and exit the printer software.

10. Click Close, OK, or Print to print your backlit display. 
(You may need to click a series of these buttons, depending 
on your software.)

Note:
If you change any other 
printer software 
settings, make sure the 
Flip Horizontal setting is 
still selected before you 
print.
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Printing a Backlit Display on a Macintosh

1. Create the document in your word processor or other 
application software.

2. Choose Page Setup from the File menu. 

3. Choose the Paper Source you’re using, either Auto Sheet 
Feeder (for the built-in sheet feeder) or Manual Feed 
Slot (for the manual feeder). 

4. Then select the size of your back light film in the 
Paper Size option. Click OK.

5. Choose Print from the File menu or click the print icon in 
your application. You see the printing dialog box (as shown 
on page 1-9). 

6. Select Ink Jet Back Light Film as the Media Type setting. 
This chooses the best printer driver settings for printing on 
back light film and automatically turns on the Flip 
Horizontal feature so your image will appear correctly 
when viewed from the reverse side.

7. Check the rest of the printer software settings as described 
in Chapters 1 and 2. Then click Print to print your backlit 
display. 

Note:
If you change any other 
printer software 
settings, make sure the 
Flip Horizontal setting is 
still selected before you 
print.
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4
Your printer software includes several utilities for managing 
print jobs. You can use them to monitor your printer’s status, 
set up large jobs to print later, and handle network printing. If 
you’re using your printer on a network, you need to follow the 
special setup procedures in this chapter. 

This chapter provides instructions for the following:

◗ Managing print jobs with Windows 95 or 3.1

◗ Managing print jobs with Windows NT

◗ Managing print jobs on a Macintosh

◗ Network printing on a PC

◗ Network printing on a Macintosh

Managing Print Jobs with 
Windows 95 or 3.1
Your Windows printer software includes two management 
utilities: the Spool Manager and Status Monitor. 

◗ The Spool Manager starts automatically when you send a 
job to the printer. It allows you to print in the background 
while you continue to work on your computer and to hold 
jobs to print at a later time. If you’re using your printer on a 
network, it also handles multiple print jobs that come in at 
the same time.

Managing
Print Jobs and

Network Printing
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◗ The Status Monitor, which is available only if you’re using 
Windows 95, also starts automatically when you send a job 
to the printer. It displays on your screen to alert you about 
printer and ink status. 

Using the Spool Manager

The Spool Manager works like the Windows Print Manager. 
When you send a job to your printer, your printer software 
creates a temporary print job file, stores it in the C:\TEMP or 
C:\WINDOWS\TEMP folder or directory, and assigns it to a 
print queue. The software then sends the file to your printer at 
the right time.

◗ To open the Spool Manager while you’re printing, click 
the Spool Manager icon that appears on the Taskbar 
(Windows 95) or at the bottom of your desktop 
(Windows 3.1). 

◗ To open it at any time, double-click the Spool Manager4 
icon in the EPSON program group or folder.

You see the Spool Manager window:

The Spool Manager window displays the status of your print 
queues and print jobs and lets you control them. Here are some 
of the things you can do:

◗ Hold or release a queue

◗ Send print jobs to your printer over a network 

◗ Hold, re-queue, or delete a print job

Note:
The Status Monitor 
doesn’t appear if you’re 
printing over a network.

In Windows 3.1, you 
may not see the Spool 
Manager icon if the 
Program Manager or 
current window is 
maximized. Make the 
window smaller to see 
the Spool Manager icon. 

menus

print job 
file

queue
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◗ Prevent the Despooler window from appearing on your 
screen whenever you print (see page 1-7 for information on 
the Despooler window)

◗ Change your default spool directory

Deleting a Stalled Print Job

If you have trouble printing, it may be because of a stalled print 
job. Follow these steps to delete it so you can continue printing:

1. Open the Spool Manager as described on page 4-2.

2. Click on any print jobs marked Held, then open the 
Document menu and click Delete. 

3. Click Yes.

4. Exit Spool Manager and try printing again.

Changing the Default Spool Directory

If you get an error message when you try to print, or printing is 
very slow, you can try changing your default spool directory. 
Follow these steps:

1. Make a directory on your hard disk where you want Spool 
Manager to store print job files, for example, 
C:\SPLTEMP.

2. Open the Spool Manager as described on page 4-2.

3. Choose Default Spool Directory from the Options menu. 

4. In the dialog box, change the spool directory to the one you 
created in step 1. Then click OK.

5. Make sure EPSON Stylus COLOR 1520 is selected, and 
then choose Setup from the Queue menu. The Queue 
Setup dialog box appears.

For information about any 
of these procedures, use 
the Spool Manager Help 
utility.
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6. Make sure the spool directory is the same as in step 1. Also 
make sure Use Print Manager for this port is checked. (If 
you’re using Windows 95 and don’t see the Status Monitor 
when you print, leave it unchecked.) Click OK.

7. Close Spool Manager.

Using the Status Monitor

The Status Monitor, available only if you’re using Windows 95, 
displays automatically in the Despooler window when you send 
a print job to the printer. However, you can use it at any time to 
see how much ink you have left. Follow these steps:

1. Access the Main printer settings dialog box as described on 
page 1-2 (Windows) or page 1-9 (Macintosh).

2. Click the Utility tab. You see the Utility menu:

3. Click the EPSON Status Monitor icon.

For information 
about these 
three utilities, 
see Chapter 6
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You see the Despooler window with the Status Monitor at 
the bottom:

4. Check the amount of ink you have left. (For more 
information about the Despooler window, see page 1-7.)

Managing Print Jobs with 
Windows NT
Windows NT 4.0 servers and workstations include a messenger 
service to alert you to printer errors or let you know when a 
print job is finished. If you have appropriate network access 
privileges or you’re controlling printing from the server, you 
can also cancel, pause, or restart print jobs and set the sharing, 
security, scheduling, and port options. See your Windows NT 
documentation for details.

You can check the status of your print job in 
Windows NT 3.51 using the Print Manager. Options in the 
Print Manager window let you pause, resume, or delete print 
jobs and handle the print queues on your system, depending on 
your network access privileges. See your Windows NT 3.51 
documentation for instructions.
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Managing Print Jobs on a 
Macintosh
Your Macintosh printer software includes two utilities for 
managing your print jobs: EPSON Monitor2 and Status 
Monitor. 

◗ If you’re using background printing, Monitor2 starts 
automatically when you send a job to the printer. It handles 
printing while you continue to work on your Macintosh 
and lets you track documents that are waiting to be printed. 

◗ The Status Monitor alerts you to any problems that occur 
during printing. You can also use it any time to see how 
much ink you have left. 

Using EPSON Monitor2

The EPSON Monitor2 utility lets you continue to work on your 
Macintosh while your document is printing. To use this utility, 
however, you need to turn on background printing and increase 
the memory allocation for Monitor2. 

Follow these steps:

1. If you didn’t turn on background printing when you 
selected your printer, open the Chooser from the Apple 
menu. Select either the EPSON Stylus(EX) or EPSON 
Stylus(AT) icon. Under Background Printing, click On 
and close the Chooser.

2. To increase the memory allocated to Monitor2, select 
EPSON Monitor2 in the Extensions folder in your System 
folder. Then choose Get Info from the File menu and set 
the Memory Requirements to 2000K or 3000K, depending 
on your system’s available RAM.

3. To use Monitor2 while you’re printing, select the EPSON 
Monitor2 icon in the Application menu at the right end of 
the menu bar. 

Note:
Background printing is 
slower and may also slow 
down your system. 
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You see a dialog box like the following:

You can select a job and cancel it or just use this window to 
track the print job’s progress.

Using the Macintosh Status Monitor

You can use the Status Monitor to check the level of ink in your 
printer and to control the way your software warns you about 
printer problems. Follow these steps:

1. Choose Print from the File menu or click the print icon in 
your application. You see the printer settings dialog box.

2. Click the Utility button. You see the Utility menu:

Job currently 
printing

Jobs queued 
for printing 
appear here

For 
information 
about these 
utilities, see 
Chapter 6

printjob.fm5  Page 7  Friday, May 9, 1997  1:52 PM



Managing Print Jobs and Network Printing

4-8

3. Click the Status Monitor icon. The software checks the 
amount of ink remaining and displays the Status Monitor: 

4. If you want to change printer messages and warnings, click 
the Configuration button. You see the following dialog 
box:

5. Choose the options you want and click OK.

Click to recheck 
ink level

Click to control 
messages and 
warnings
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Network Printing on a PC
You can use your printer on a network under Windows NT, 
Windows 95, or another network operating system. First you 
need to set up your printer using either the network’s printer 
setup functions or your printer software’s built-in network 
support.

If you’re setting up your printer for Windows NT, see the 
instructions below. For other network operating systems, see 
your network documentation for instructions or use the printer 
software’s network support, as described on page 4-11.

Connecting to the Printer on 
Windows NT 4.0 Systems

If you installed an optional network interface card in your 
printer and installed the printer software as described in the 
Quick Setup booklet, follow the steps below to connect the 
remote printer to each system on the network using the TCP/IP 
(or LPR) protocol.

1. Follow the instructions to configure the interface card in 
the manual that came with the card.

2. To connect the printer to a TCP/IP (or LPR) port, open 
the Control Panel and select Printers.

3. Right-click the EPSON Stylus COLOR 1520 icon, then 
select Properties.

4. Select the Ports tab and click the Add Port button.

5. Select LPR Port in the Port list. Then click New Port.

6. Type the IP address of the card in the first box and type 
a short name for the printer in the second box. Then 
click OK.

7. Click Close. 

Note:
If you need to install a 
network interface board 
in your printer, see 
Appendix A for 
instructions.

Note:
If you connected the 
printer directly to a 
Windows NT server or 
you’re using a different 
network protocol, see 
your Windows NT 
documentation for 
instructions on 
configuring your printer 
for the network. If you’re 
using an optional 
interface card, also see 
the documentation that 
came with the card.
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8. You see the address and name of the printer in the Port list. 
Click OK to exit printer properties.

Now you can print to the remote printer. Repeat these steps for 
each system on the network that needs to access the printer.

Connecting to the Printer on 
Windows NT 3.51 Systems

If you installed an optional network interface card in your 
printer and installed the printer software as described in the 
Quick Setup booklet, follow the steps below to connect the 
remote printer to each system on the network using the TCP/IP 
(or LPR) protocol.

1. Follow the instructions to install the LPR software and 
configure the interface card in the manual that came with 
the card.

2. To configure the printer for TCP/IP (or LPR) printing, 
double-click the Print Manager icon in the Main program 
group.

3. Select the EPSON Stylus COLOR 1520 window.

4. Choose Properties in the Printer menu.

5. Select Other in the Print to list.

6. Select LPR Port in the Available Print Monitors list and 
click OK.

7. Type the IP address of the card in the first box and type 
a short name for the printer in the second box. Then 
click OK.

8. Click OK again, then exit Print Manager.

Now you can print to the remote printer. Repeat these steps for 
each system on the network that needs to access the printer.

Note:
If you connected the 
printer directly to a 
Windows NT server or 
you’re using a different 
network protocol, see 
your Windows NT 
documentation for 
instructions on 
configuring your printer 
for the network. If you’re 
using an optional 
interface card, also see 
the documentation that 
came with the card.

If you’ve connected the 
printer to a server, be 
sure to install the 
Windows NT 3.51 
software on all 
workstations that will 
share the printer over 
the network.
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Using the Printer Software’s Built-in 
Network Support

To use your printer software’s built-in network support, you 
first need to install the printer software on all the network 
computers that will use the printer. See the Quick Setup booklet 
for instructions. Once the printer software is installed, you can 
set up Spool Manager to send print job files from each 
computer to a shared directory on the computer connected to 
the printer. 

Follow the steps in the next sections to set up a print job 
directory on the system connected to the printer (the host 
system) and each remote system (client) on the network. For 
Windows 95, you also need to specify the port and network 
path to the printer, as described on page 4-12.

Setting Up the Host System

Follow these steps to set up the computer connected to the 
printer:

1. Create an icon for the EPSON Spool Manager 
(EPSPLMGR.EXE in the \WINDOWS\SYSTEM folder 
or directory).

2. Place this icon in the Startup folder.

3. Double-click the EPSON Spool Manager icon to open the 
Spool Manager window.

4. Double-click the queue you want to use for network 
printing. The Queue Setup dialog box appears.

5. Click the Remote Despool tab and then click the 
Printing from remote queues option.

6. Click the Browse button and select the remote server 
directory that will receive print job files.

7. Click OK and minimize the Spool Manager window.
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Setting Up Remote Systems

Follow these steps to set up the client computers on the 
network:

1. Open the Spool Manager window as described on page 4-2.

2. In the Spool Manager window, double-click the queue you 
want to use for network printing. The Queue Setup dialog 
box appears.

3. Click the Spool to remote printer button.

4. Click the Browse button and select the directory you’re 
using for print job files on the host system.

5. Click OK and minimize the Spool Manager window.

Setting Up Your Network Path in Windows 95

If you want to use your printer on a network running 
Windows 95, you need to set up the port and network path on 
the computer connected to the printer. Follow these steps:

1. Double-click My Computer.

2. Double-click the Printers folder.

3. Right-click the EPSON Stylus COLOR 1520 icon and 
choose Properties.

4. Click the Details tab. 
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The following dialog box appears:

5. Click the Add Port button, then specify the network path 
to the printer and click OK.

6. Open the Spool Manager window as described on page 4-2.

7. In the Spool Manager window, double-click your printer’s 
queue. The Queue Setup dialog box appears.

8. Make sure the Use Print Manager for this port option is 
checked. Then click OK.

Network Printing on a Macintosh
If you want to use your printer on an AppleTalk™ network, you 
need to install an optional interface board: either the 
LocalTalk® board or the Ethernet™ board. See Appendix A for 
more information about optional interfaces.

Then you can use the EPSON Namer utility and set up your 
printer in the Chooser. The EPSON Namer was installed on 
your hard drive along with the other printer software. 

Note:
To print from DOS 
applications as well as 
Windows applications, 
click the Capture Printer 
Port button instead of 
Add Port. Select the 
printer port in the Device 
list, then specify its 
network path. Select 
Reconnect at logon, then 
click OK.
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Assigning a Name to the Printer

Follow these steps to use the EPSON Namer utility:

1. Double-click the EPSON Namer icon on your hard drive. 

2. Click the EPSON Stylus(AT) icon in the Device Types 
window.

3. Select the AppleTalk zone where your printer is located.

4. Under New Name, type a name from your printer to 
distinguish it from other printers on the network.

5. Click Rename and then click Done.

Setting Up the Printer for AppleTalk

Make sure your printer is turned on and then follow these steps 
to set up your printer on an AppleTalk network:

1. Open the Chooser from the Apple menu. You see a dialog 
box like the following:

2. Click the EPSON Stylus(AT) icon.

3. Select the AppleTalk zone you want to use. A list of all 
printers connected to the selected zone appears on the right.
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4. Click the name you assigned to your EPSON Stylus COLOR 
1520 in step 4 of the previous section. You see a prompt 
asking you to confirm your choice.

5. Click OK.

If your printer name doesn’t appear, make sure the printer 
is turned on and correctly connected, then click RETRY.

6. To ensure compatibility, leave Background Printing 
turned off.

7. Close the Chooser.
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If you print with DOS application programs, you can use your 
printer with them by following the instructions in this chapter. 
It covers these operations:

◗ Selecting printer software for DOS

◗ Changing printer settings with default-setting mode

◗ Performing printer maintenance procedures, such as 
aligning the print heads

◗ Selecting character tables

◗ Using printer commands

Selecting Printer Software for DOS
You select software for your printer (a printer driver) in each 
DOS program you use. Most DOS programs include a driver 
for EPSON ESC/P 2™ printers. You need to select the correct 
printer driver to take advantage of your printer’s advanced 
built-in scalable fonts and graphics handling.

Most DOS programs require you to select from a list of 
available printer drivers. If EPSON Stylus COLOR 1520 is not 
included in the list, you can contact your software manufacturer 
to obtain an updated driver. 

If an updated driver is not available, pick the first printer 
available in the lists on the next page.

Using Your
Printer with

DOS

Note:
To use your printer with 
AutoCAD® 386 (DOS 
Extender) releases 10 
and higher that support 
ADI plotter drivers, see 
the README file on the 
ADI plotter driver diskette 
or printer software 
CD-ROM.
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When printing black and color, select:

EPSON Stylus 1500
EPSON Stylus Pro
EPSON Stylus Pro XL
EPSON Stylus COLOR 500
EPSON Stylus COLOR II
LQ-2550
LQ-1070

When printing black only, select:

LQ-870
LQ-1170
LQ-500
LQ-570
LQ-570+
LQ-1070
LQ-1070+
SQ-870 
SQ-1070
LQ-850

Once you’ve selected a printer driver for each DOS program 
you use, you can begin printing. Be sure to check the paper 
source and other printer driver settings before you print.

If you want to adjust any of the printer’s internal settings, you 
can use default-setting mode as described in the next section.

To perform routine printer maintenance procedures, see 
page 5-7 for instructions.

Note:
The drivers for the printers 
listed do not provide all 
EPSON Stylus COLOR 
1520 features, such as 
1440-dpi printing, 720-dpi 
printing, and MicroWeave.
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Changing Printer Settings with 
Default-Setting Mode
Your printer includes internal default settings that are active 
whenever you turn on the printer. These settings control 
functions such as the print direction and paper loading 
positions. 

Because they are preset to the most likely settings you’ll want to 
use, you probably won’t need to change them. However, you 
may want to change settings such as these for special projects:

◗ Turn on auto tear-off mode when you print on continuous 
paper or roll paper (but not when printing continuous 
labels)

◗ Turn on banner mode when you print on roll paper

◗ Select a slashed zero (0/) instead of a regular zero (0) when 
you print documents where the zero can easily be confused 
with a capital “O”

You can check or change the default settings using the printer’s 
control panel. Follow the steps in the next section.

Entering Default-Setting Mode

To enter default-setting mode and print an instruction sheet in 
your language, follow these steps:

1. Load four or more sheets of paper, at least 8.3 inches 
(210 mm) wide, into the built-in sheet feeder, making sure 
the right edge guide is positioned correctly for your paper’s 
width and the paper release lever is set to the single sheet 
position. See page 3-6 for loading instructions.

2. Turn off the printer.

Note:
The printer’s control 
panel buttons perform 
different functions while 
the printer is in default-
setting mode. Be sure to 
carefully follow the 
instructions your printer 
prints and don’t try to 
perform standard control 
panel functions until 
you’ve exited 
default-setting mode.
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3. Hold down the Micro Adjust D button and press the 
P Operate button to turn on the printer and enter 
default-setting mode. Release the Micro Adjust D button 
when the Operate light comes on.

The printer loads a sheet of paper and prints an instruction 
sheet telling you how to select a language (the default 
setting is English). The printer can then print 
default-setting instructions in the language you choose.

4. Press the Alt button until the Ink Out B and Ink Out A 
lights on your control panel indicate the language you want 
to use.

English Both lights off
French Ink Out B on and Ink Out A off
Spanish Both lights on
Portuguese Ink Out B flashing and Ink Out A on
German Ink Out B flashing and Ink Out A off
Italian Ink Out B off and Ink Out A on

5. Press the Pause button. The printer prints instructions on 
changing the default settings.

6. Follow the instructions on the sheets to change the 
necessary settings, as listed in the next section. Your 
changes remain in effect until you change them again. 
(To exit without changing any settings, press the Pause 
button.)

7. When you’re finished changing settings, press Load/Eject 
if you need to eject any loaded paper. Then turn off the 
printer to exit default-setting mode.

8. Wait five seconds, then turn on your printer to resume 
printing normally.
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List of Default-Setting Options

The table below lists all the options available for each default 
setting. The factory defaults are listed in bold type in the table 
below. The printer’s current settings are marked with a ⇐ on 
your printed instruction sheet.

Setting Options Description

Print direction Auto, Bi-D, Uni-D Auto switches between bidirectional 
printing for text data (the print head prints 
in both directions) and unidirectional 
printing for graphics data. For the fastest 
printing of text only, select Bi-D; but if 
vertical lines become misaligned, you’ll 
need to turn it off or align the print heads 
(see page 5-7 for instructions). For the 
most accurate alignment when printing 
graphics, select Uni-D.

Font Courier, Roman, 
Sans Serif, Script 
Prestige, Roman T, 
Sans Serif H, Draft

If your software doesn’t let you select 
fonts, you can select one of these bitmap 
or scalable fonts. See Appendix C for a list 
of the point size and characters per inch 
available with each font.

Pitch 10, 12, 15, 17.1, or 
20 cpi, or 
Proportional

If your software doesn’t let you select 
point size or characters per inch for your 
fonts, you can select one of these. See 
Appendix C for a list of the point size and 
characters per inch available with each 
font. 

I/F (interface) mode Auto, Parallel, 
Serial, Option

When your printer is connected to multiple 
interfaces, Auto sets the printer to receive 
data from any interface sending a print job. 
Select Parallel, Serial, or Option only if you 
want your printer to ignore print jobs sent 
from other interface types.

Auto I/F (interface) wait time 10 or 30 seconds If you choose Auto for the I/F mode 
setting, selects the time the printer waits 
for a print job from one interface before 
accepting a print job from another 
interface.
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Software (emulation mode) ESC/P 2, IBM 
XL24E

Specifies the control mode you want the 
printer to use. For the best font and 
graphics control, always use ESC/P 2 
mode. If you need to emulate an IBM® 
Proprinter,™ select IBM XL24E mode. For 
a list of the commands for these modes, 
see page 5-17.

Auto CR (IBM XL24E mode 
only)

Off, On In IBM XL24E mode, lets you select 
whether the printer performs a 
carriage-return line-feed operation when it 
reaches the right margin (On) or only when 
it receives a carriage-return code in the 
print job (Off).

AGM (IBM XL24E mode only) Off, On In IBM XL24E mode, turns high resolution, 
24-pin graphics command mode on or off.

Character table — See the samples beginning on page 5-8. 
The default character table is PC437.

International character set for 
Italic table

— See the samples beginning on page 5-8. 
The default character set is Italic U.S.A.

Auto line feed Off, On Sets the printer to perform a line-feed 
operation every time it receives a 
carriage-return command (On), or not to 
perform one (Off).

Network I/F (interface) mode Off, On Sets whether the printer is (On) or is not 
(Off) shared by more than one computer.

0 slash 0, 0/ Selects either a slashed zero (0/ ) or a 
regular zero (0) to be printed when a zero 
command is received.

Page length 11, 12, 8.5, or 70/6 
inches

When printing on continuous paper, select 
the length of the individual sheets. 70/6 is 
the length of A4-size paper.

Skip over perforation Off, On If your software doesn’t let you set top and 
bottom margins, turn this setting On to add 
a one-inch margin over the perforation to 
separate text on continuous pages.

Setting Options Description
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Maintaining the Printer
When you’re printing from DOS applications, you can perform 
most printer maintenance operations as they’re described in 
Chapter 6, such as replacing the ink cartridges and cleaning or 
aligning the print heads from the control panel. 

However, you can use a DOS utility as described in this section 
if you need to align the print heads to correct misaligned 
vertical lines.

Aligning the Print Heads with a DOS Utility

Before you can align the print heads, you need to install the 
DOS alignment utility. Follow these steps:

1. Make sure your computer and printer are turned on.

Auto tear off Off, On When printing on continuous paper or roll 
paper, turn this setting On to advance the 
perforation or end of the roll paper 
document to the printer’s tear-off edge. It 
also backs the paper up to the top-of-form 
position when it receives the next print job. 
Turn this setting Off when printing on 
continuous labels so they don’t peel off 
inside the printer.

Banner mode Off, On When you turn this mode On, roll paper is 
treated like continuous paper, even with 
the paper release lever in the single sheet 
position. This prevents the printer from 
advancing too much roll paper forward 
when you press the LF/FF button.

Parallel I/F (interface) transfer 
rate

Fast, Normal Sets the transfer rate for printing across 
the parallel port. Always select Fast unless 
you receive transfer rate errors.

Setting Options Description

If vertical lines are 
misaligned, first make 
sure you did not set the 
Print direction setting to 
Bi-D (bidirectional) in 
default-setting mode. 
This may be causing the 
problem instead of truly 
misaligned print heads. 
See page 5-3 for 
instructions on checking 
your default settings.
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2. Load several sheets of paper at least 8.3 inches (210 mm) 
wide in the built-in sheet feeder, making sure the right edge 
guide is positioned correctly for your paper’s width. Also 
make sure the paper release lever is set to the single sheet 
position. (See page 3-6 for instructions.)

3. Insert the EPSON printer software CD-ROM or diskette 
into a drive.

4. At the DOS prompt, type d:\SETUP (where d is the drive 
letter of your drive) and press Enter.

5. You see an installation instruction screen. Follow the 
instructions on the screen to install the utility on your 
computer’s hard disk drive.

6. Once the utility is installed, log onto the directory you 
specified for the utility. Then type EPCALIB and press 
Enter to start the program.

7. You see the EPSON Print Head Alignment Utility main 
screen. Make sure your printer is listed on the screen and 
select Next.

8. Follow the instructions on the utility screens to align your 
print heads.

Selecting Character Tables
Most of the time you can select character tables using your 
application software. If you can’t select them with your 
software, follow the instructions here to select one of the 
printer’s internal character tables.

You can select a character table using default-setting mode 
(as described on page 5-3) or printer sofware commands (as 
described on page 5-17). Each character table is identified by 
the code shown beneath the sample, beginning on the next 
page.

Note:
You can use a mouse 
with the utility if you have 
a DOS mouse driver 
installed.

Note:
Some tables contain the 
same characters for hex 
codes 00 to 7F as the 
PC437 table, so these 
samples list only 
characters for codes 80 
to FF.
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PC437 (U.S., Standard Europe) PC437 Greek (Greek)

PC850 (Multilingual) PC853 (Turkish)
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PC855 (Cyrillic) PC852 (East Europe)

PC857 (Turkish) PC860 (Portuguese)
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PC863 (Canadian-French) PC865 (Norwegian)

PC866 (Russian) PC861 (Icelandic)
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PC869 (Greek) BRASCII (Brazilian, Portuguese)

Abicomp (Brazilian, Portuguese) Roman 8
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ISO Latin 1 MAZOWIA (Poland)

Code MJK (CSFR) ISO 8859-7 (Latin/Greek)
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ISO Latin 1T (Turkish) Bulgaria (Bulgaria)

PC774 (LST 1283:1993) Estonia (Estonia)
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ISO 8859-2 PC866 LAT (Latvian)

Italic

No characters are available for hex 
code 15 in the italic character table.
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International Character Sets

You can select one of these international character sets using 
default-setting mode (as described on page 5-3) or the ESC R 
command (as described on page 5-17). When you select a 
character set, such as Italic France, the characters in the France 
row on the table below are used in the italic character table.

You can select one of these eight international character sets 
using default-setting mode or ESC R.

You can select one of these seven sets using ESC R only.
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Characters Available with the ESC ( ^ 
Command

To print with the characters listed below, use the ESC ( ^ 
command as described in the next section.

Using Printer Commands
You can operate your printer by using commands in one of two 
control code modes. For the best font and graphics control, 
always use EPSON ESC/P 2 mode. (For details on using 
ESC/P 2, see the ESC/P Reference Manual available from 
EPSON.)

If you need to emulate an IBM Proprinter, select IBM XL24E 
mode. (See IBM’s X24/X24E reference manual.)
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ESC/P 2 Control Codes

General operation:
ESC@, ESC U, ESC EM

Paper feeding:
CR, FF, LF, ESC 0, ESC 2, ESC 3, ESC +

Page format:
ESC ( C, ESC C, ESC C 0, ESC Q, ESC l, ESC ( c, 
ESC N, ESC O

Print position motion:
ESC $, ESC \, ESC ( V, ESC ( v, ESC D, HT, ESC B, 
ESC J, VT

Font selection:
ESC k, ESC x, ESC X, ESC P, ESC M, ESC g, ESC p,
ESC 4, ESC 5, ESC E, ESC F, ESC !

Font enhancement:
ESC W, DC 4, SO, DC2, SI, ESC w, ESC G, ESC H,
ESC T, ESC S, ESC -, ESC ( -, ESC q

Spacing:
ESC SP, ESC c, ESC ( U

Character handling:
ESC t, ESC ( t, ESC R, ESC %, ESC &, ESC :, ESC 6,
ESC 7, ESC ( ^ 

Bit image:
ESC *

 Graphics: 
ESC ( G, ESC ., ESC ( e, ESC ( i, ESC ( \, ESC ( s 

Color: 
ESC r, ESC ( r

Printing mode:
ESC ( K
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IBM XL24E Emulation Control Codes

In the following commands, “(AGM)” indicates Alternate 
Graphics Mode commands. Do not type these characters as part 
of the command.

General operation:
NUL, DC3, ESC j, BEL, CAN, DC1, ESC Q, ESC [ K,
ESC U

Paper feeding:
FF, LF, ESC 5, ESC A, ESC A (AGM), ESC 0, ESC 1,
ESC 2, ESC 3, ESC 3 (AGM), CR

Page format:
ESC C, ESC X, ESC N, ESC O, ESC 4

Print position motion:
ESC d, ESC R, ESC D, HT, ESC B, VT, ESC J, 
ESC J (AGM)

Font selection:
DC2, ESC P, ESC :, ESC E, ESC F, ESC I

Font enhancement:
DC4, SO, ESC SO, ESC W, ESC [ @, SI, ESC SI, ESC G,
ESC H, ESC T, ESC S, ESC -, ESC _

Spacing:
BS, SP, ESC [ \

Character handling:
ESC 6, ESC 7, ESC [ T, ESC ^, ESC \

Bit image:
ESC K, ESC L, ESC Y, ESC Z, ESC [ g, ESC * (AGM)
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It’s easy to keep your EPSON Stylus COLOR 1520 printer 
working at its best. All you have to do is follow the simple 
instructions in this chapter for replacing ink cartridges, 
performing routine maintenance, and moving the printer. 

This chapter covers the following procedures:

◗ Cleaning the print heads

◗ Replacing an ink cartridge

◗ Aligning the print heads

◗ Cleaning the printer

◗ Transporting the printer

Cleaning the Print Heads
If your printed image is unexpectedly light or faint, or dots are 
missing from the image, you may need to clean the print heads. 
This unclogs the nozzles so they can deliver ink properly.

Cleaning the print heads uses ink, so clean them only if print 
quality declines. You can use either of the following to clean the 
print heads:

◗ The Head Cleaning utility in your printer software (when 
your printer is connected directly to your computer)

◗ The printer’s control panel buttons (when you’re using 
DOS, or your printer is connected via an optional network 
interface card, or you don’t want to use the Head Cleaning 
utility)

Maintenance and
Transportation
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Using the Head Cleaning Utility

Follow these steps to run the utility from a Windows or a 
Macintosh computer connected directly to the printer:

1. Make sure the printer is turned on but not printing.

2. To clean the black print head, make sure the Ink Out B 
light is off. To clean the color print head, make sure the 
Ink Out A light is off. 

3. Access the Main printer settings dialog box as described in 
Chapter 1.

4. Click the Utility tab (Windows) or the Utility button 
(Macintosh). You see the Utility menu.

5. Click the Head Cleaning icon.

6. Follow the instructions on the screen to clean the print 
heads. Cleaning each head takes about two minutes, during 
which the printer makes some noise and the Pause light 
flashes. 

When the Pause light stops flashing, you need to run a 
nozzle check to test the print quality and reset the cleaning 
cycle.

7. Make sure paper is loaded in the printer and click Print 
nozzle check pattern (Windows) or Confirmation 
(Macintosh), and then click Next. See page 6-4 for 
instructions on examining the nozzle check pattern.

If your print quality has not improved, repeat the steps above. If 
you don’t notice any improvement after doing this two or three 
times, check the print quality solutions in Chapter 7.

Note:
If either Ink Out light is 
flashing or on, you need 
to replace the ink 
cartridge instead. See 
page 6-4 for instructions.

Caution:
Never turn off the printer 
while the Pause light is 
flashing.

If, however, the Pause 
light is still flashing after 
10 minutes and the 
printer is not moving or 
making noise, you may 
turn off the printer.
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Using the Control Panel

1. Make sure the printer is turned on and not printing.

2. To clean the black print head, make sure the Ink Out B 
light is off. To clean the color print head, make sure the 
Ink Out A light is off. 

3. Press the Pause button. The Pause light comes on.

4. To clean the black print head, press the Alt and Cleaning B 
buttons. Or, to clean the color print head, press the Alt and 
Cleaning A buttons.

Cleaning each head takes about two minutes, during which 
the printer makes some noise and the Pause light flashes. 

5. After the cleaning cycle is complete and the Pause light 
stays on without flashing, you can repeat step 4 to clean the 
other print head, if you wish.

6. When you’re finished cleaning the print heads, press the 
Pause button to turn off the Pause light.

7. Now you need to print a page to test the print quality and 
reset the cleaning cycle. If you’re using DOS or a network 
interface card, open an application and print a document 
containing black and color data. Then go to step 10.

If you’re connected directly to the printer, run a nozzle 
check. Go to step 8.

8. Access the Main printer settings dialog box as described in 
Chapter 1. Then click the Utility tab (Windows) or the 
Utility button (Macintosh). You see the Utility menu.

9. Click the Nozzle Check icon, then click Next. See 
page 6-4 for instructions on examining the nozzle check.

10. If your print quality has not improved, repeat the steps 
above. If there’s no improvement after doing this two or 
three times, check the print quality solutions in Chapter 7.

Note:
If either Ink Out light is 
flashing or on, you need 
to replace the ink 
cartridge instead. See 
page 6-4 for instructions.

Caution:
Never turn off the printer 
while the Pause light is 
flashing.

If, however, the Pause 
light is still flashing after 
10 minutes and the 
printer is not moving or 
making noise, you may 
turn off the printer.
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Examining the Nozzle Check Pattern

Examine the nozzle check pattern you print. It should look 
something like this, with the lower pattern colored cyan, 
magenta, and yellow:

Each staggered horizontal and straight vertical line should be 
complete, with no gaps in the dot pattern. If your printout 
looks okay, you’re done. If any dots are missing, clean the print 
heads again, as explained in the previous sections.

Replacing an Ink Cartridge
When an Ink Out light flashes, the indicated cartridge is low on 
ink. This is a good time to make sure you have a new cartridge. 
When the light stays on, the cartridge is empty and you need to 
replace it.

If your color ink cartridge runs out of ink, you can continue 
printing in black ink. See page 6-7 for instructions.

Use these EPSON ink cartridges within six months of installing 
them and before the expiration date on the package:

Black ink cartridge S020108
Color ink cartridge S020089

When you need new ink cartridges, contact your dealer or call 
EPSON Accessories at (800) 873-7766 (U.S. only). In Canada, 
please call (800) 873-7766 for dealer referral.

W02271 C01267

Caution:
For best results, don’t 
replace an ink cartridge 
unless its Ink Out light is 
flashing or on.

To ensure good results, 
use genuine EPSON 
cartridges and do not refill 
them. Other products may 
cause damage to your 
printer not covered by 
EPSON’s warranty.
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Removing and Installing an Ink Cartridge

You should replace an ink cartridge only when the Ink Out B or 
Ink Out A light is flashing or on. However, if you need to 
replace an outdated cartridge, you can do so before its Ink Out 
light comes on. 

1. Make sure the printer is turned on and not printing. 

2. Open the printer cover. The Cover Open and Pause 
lights come on.

3. Remove the new ink cartridge from its packaging. Then 
completely remove the yellow portion of the tape seal as 
shown:

4. Hold down the Alt button on the printer’s control panel 
for about three seconds. 

The print heads move slightly left and the Pause light 
begins flashing. (The print heads return to their home 
position if you don’t proceed to step 5 within 60 seconds.)

5. Pull up the ink cartridge clamp for the cartridge you need 
to replace. The cartridge rises up from its holder.

Caution:
To avoid damaging the 
printer, never move the 
print heads by hand.

Once you remove an ink 
cartridge, it becomes 
unusable and cannot be 
reinstalled.

You must completely 
remove the yellow tape 
seal from the top of the 
cartridge; leaving any 
portion of it on will 
permanently damage the 
cartridge. Do not remove 
the clear seal from the 
bottom of the cartridge; 
ink will leak out.

black cartridge color cartridge
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6. Lift the cartridge out of the printer and dispose of it 
carefully. 

7. Lower the new ink cartridge into its holder with the label 
facing up and the arrow pointing to the back of the printer. 
The larger cartridge (color) goes on the right, the black ink 
cartridge on the left.

8. Press down the ink cartridge clamp until it locks in place.

9. Press the Alt button and close the printer cover. 

The printer moves the print heads and begins charging the 
ink delivery system. (Even if you don’t press the button, ink 
charging begins 60 seconds after you close the clamp.)

ink cartridge clamp

Warning:
If ink gets on your hands, 
wash them thoroughly with 
soap and water. If ink gets 
into your eyes, flush them 
immediately with water.

Caution:
Don’t open the clamp or 
remove a cartridge 
except to replace it with 
a new one. Once you 
remove a cartridge, you 
can’t reuse it, even if it 
contains ink.
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The Pause light flashes and the printer makes various 
sounds. Charging takes about several minutes, depending 
on whether you replaced one or both cartridges. 

When it’s finished, the Pause light stays on; press the 
Pause button to turn it off and resume printing. 

Printing in Black Ink with an Empty Color 
Cartridge

If your color ink cartridge runs out of ink and the Ink Out A 
light comes on, you can still continue printing with black ink. 
(If the black ink cartridge runs out of ink, you cannot continue 
printing.) However, you will need to resend any print job you 
were printing when the color ink ran out. Follow these steps:

1. Turn off the printer.

2. Wait about five seconds and then turn the printer back on 
again. Don’t remove the empty color ink cartridge.

3. Press the Load/Eject button to eject any paper in the paper 
path or advance continuous paper to the tear-off edge. Tear 
off any continuous sheets and press Load/Eject again to 
park the continuous paper out of the path.

4. Access the printer software in your application as described 
in Chapter 1. Change the Ink setting for your document to 
Black and change any other settings as necessary. Then 
print the document.

To switch back to color printing, follow the steps beginning on 
page 6-4 to replace the color ink cartridge. Then turn the 
printer off and on again to reset color printing mode. Before 
you print, be sure to set the Ink setting to Color in your printer 
software as described in Chapters 1 and 2.

Caution:
Never turn off the printer 
while the Pause light is 
flashing.

If, however, the Pause 
light is still flashing after 
10 minutes and the 
printer is not moving or 
making noise, you may 
turn off the printer.

Caution:
If you’re printing on 
continuous label paper, 
don’t press Load/Eject; 
this feeds the paper 
backward and may cause 
labels to tear off inside 
the printer. Follow the 
steps on page 3-18 
instead.
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Aligning the Print Heads
If your printouts contain misaligned vertical lines, you may 
need to align the print heads. There are several ways to do this:

◗ If you’re using a Windows or Macintosh computer 
connected directly to the printer, you can use the Print 
Head Alignment utility in your printer software, as 
described below.

◗ If you’re printing from DOS, you can use the DOS Print 
Head Alignment utility. See page 5-7 for instructions.

◗ If you’re connected to the printer via an optional network 
interface card or you don’t want to use the Print Head 
Alignment utility, you can use the control panel to align the 
print heads. See page 6-9 for instructions.

Using the Print Head Alignment Utility

1. Turn on the printer and load paper in the built-in sheet 
feeder, making sure the right edge guide is positioned 
correctly for your paper’s width and the paper release lever 
is in the single sheet position. See page 3-6 for instructions.

2. Access the Main printer settings dialog box as described in 
Chapter 1.

3. Click the Utility tab (Windows) or the Utility button 
(Macintosh). You see the Utility menu.

4. Click the Print Head Alignment icon.

5. Follow the instructions on the screen to print an alignment 
test page and select the correct alignment.

Caution:
Load paper that’s at least 
8.3 inches (210 mm) wide 
so ink doesn’t spray onto 
the platen.

maintran.fm5  Page 8  Friday, May 9, 1997  2:10 PM



Maintenance and Transportation

6-9

Using the Control Panel

1. Turn on the printer and load paper in the built-in sheet 
feeder, making sure the right edge guide is positioned 
correctly for your paper’s width and the paper release lever 
is in the single sheet position. See page 3-6 for instructions.

2. Turn off your printer.

3. Hold down the Pause button and turn on the printer to 
turn on print head alignment mode.

The printer loads a sheet of paper and prints an instruction 
sheet telling you how to select a language (the default 
setting is English). The printer can then print instructions 
on aligning the print heads in the language you choose.

4. Press the Alt button until the Ink Out B and Ink Out A 
lights on your control panel indicate the language you want 
to use.

English Both lights off
French Ink Out B on and Ink Out A off
Spanish Both lights on
Portuguese Ink Out B flashing and Ink Out A on
German Ink Out B flashing and Ink Out A off
Italian Ink Out B off and Ink Out A on

5. Press the Pause button. The printer prints instructions on 
aligning the print heads using the control panel.

6. Follow the instructions on the sheet. When the print heads 
are aligned, turn off the printer to exit print head alignment 
mode.

7. After five seconds, turn on the printer to resume printing.

Caution:
Load paper that’s at least 
8.3 inches (210 mm) wide 
so ink doesn’t spray onto 
the platen.
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Cleaning the Printer
To keep your printer working at its best, you should clean it 
several times a year, following these steps:

1. Turn off the printer, unplug the power cord, and 
disconnect the printer cable.

2. Remove the paper from all the paper feeders.

3. Carefully clean away dust and dirt with a soft, damp cloth.

4. Clean the exterior of the printer with a soft, damp cloth. 
Keep the printer cover closed so water doesn’t get inside.

5. Clean ink out of the printer’s interior with a soft, damp 
cloth.

Transporting the Printer
To move your printer some distance, you need to prepare it for 
transportation in its original box. Follow these steps:

1. Turn on the printer and wait until the print heads lock in 
the far right position. Then turn off the printer.

2. Unplug the power cord from the electrical outlet. Then 
disconnect the interface cable from the printer.

3. Remove the paper from all the feeders. Then remove the 
paper support, output tray, and cable cover (if installed).

4. Repack the printer and attachments in the original box 
using the protective materials that came with it. See the 
Notice Sheet that was packed with the printer.

Be sure to keep the printer level, in an upright position, as you 
transport it. If print quality declines after transporting the 
printer, clean the print heads; if output is misaligned, align the 
print heads. See the instructions in this chapter.

Caution:
Don’t touch the gears 
inside the printer.

Never use alcohol or 
thinner for cleaning; they 
can damage the printer 
components and case.

Don’t use a hard or 
abrasive brush.

Don’t get water on the 
printer components.

Don’t spray lubricants or 
oils inside the printer.

Caution:
To avoid damage, always 
leave the ink cartridges 
installed when 
transporting the printer.

maintran.fm5  Page 10  Friday, May 9, 1997  2:10 PM



7-1

7
As you use your printer, you may occasionally experience a 
paper jam or other problem. The first thing you should do is 
diagnose the problem following the guidelines in this chapter. 
Then try the most likely solutions until the problem is fixed. 

This chapter tells you everything you need to know about the 
following:

◗ Diagnosing problems

◗ Improving print quality

◗ Solving printing problems

◗ Fixing paper jams and other paper problems

◗ Solving miscellaneous printout problems

Diagnosing Problems
Your printer includes a number of ways to help you diagnose 
problems:

◗ To identify the most common problems, check the lights 
on the printer’s control panel. See page 1-13 for 
instructions.

◗ You can also use the Status Monitor utility to identify 
common problems. For instructions, see page 4-4 
(Windows 95) or page 4-7 (Macintosh).

◗ To determine whether the problem is caused by the printer 
itself, run a printer self test. See the next section for 
instructions.

Troubleshooting
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◗ If you’re experienced with reading hexadecimal code, you 
can print a hex dump to identify possible communication 
problems. See page 7-3 for instructions.

◗ For the latest information, check the EPSON Stylus 
COLOR 1520 Help program and the ReadMe file in the 
EPSON program group or folder. 

◗ If none of the suggested solutions in this chapter solve your 
problem, contact EPSON as described under “Where to Get 
Help” in the Introduction.

Running a Self Test

You can run a printer self test to determine whether the 
problem lies with the printer itself or some other source. 

◗ If the test results are satisfactory, the problem lies in 
software settings, the interface cable, or your computer.

◗ If the test pages don’t print correctly, you may have a 
problem with your printer. See the suggestions in this 
chapter for possible solutions.

Follow these steps to test the printer:

1. Load several sheets of paper in the built-in sheet feeder, 
making sure the right edge guide is positioned correctly for 
your paper’s width and the paper release lever is in the 
single sheet position. See page 3-6 for instructions.

2. Turn off the printer.

3. Hold down the Load/Eject button and press the 
POperate button to turn on the printer. Then release 
both buttons. This prints the test pages at 360 dpi. (To 
print test pages at 180 dpi, hold down the LF/FF button 
while turning on the printer instead of Load/Eject.)

Caution:
Use paper that’s at least 
8.3 inches (210 mm) wide 
so ink doesn’t spray onto 
the platen.
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The first page prints on the first and last lines to measure 
the page length. The next page contains a nozzle check 
pattern and the printer’s ROM version, along with 
multicolored character samples. (The 180 dpi test prints 
black character samples.)

If the test pages don’t print, turn off the printer. Then 
repeat this step, holding down the Load/Eject button a bit 
longer before releasing it.

4. After the second page prints, press the Pause button to 
stop test printing. 

5. If the printer loaded any additional paper, press Load/Eject 
to eject it. Then turn off the printer to end the test.

Printing a Hex Dump

If you’re experienced reading hexadecimal code, you can print a 
hex dump to pinpoint communication problems between your 
computer and printer. Then you can interpret the code yourself 
or report the results to a support technician.

1. Load several sheets of paper in the built-in sheet feeder, 
making sure the right edge guide is positioned correctly for 
your paper’s width and the paper release lever is in the 
single sheet position. See page 3-6 for instructions.

2. Turn off the printer.

3. Hold down the LF/FF and Load/Eject buttons and press 
the POperate button to turn on the printer. Then release 
all the buttons. 

4. Open an application and send a print job. The printer 
prints the data in hexadecimal code.

5. When printing is finished, turn off the printer to exit 
hexadecimal mode.

Caution:
Never turn off the printer 
while it’s printing test 
pages. Always press the 
Pause button and eject 
any loaded paper first.

Caution:
Use paper that’s at least 
8.3 inches (210 mm) wide 
so ink doesn’t spray onto 
the platen.
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Improving Print Quality
You can often improve print quality by doing the following:

◗ Clean the print heads (see Chapter 6 for instructions).

◗ Use higher quality paper that’s appropriate for your print 
job (see Chapter 3 for a list of EPSON papers).

◗ Match the Media Type setting in the printer software to 
the type of media you loaded in the printer (see Chapter 3 
for details).

◗ Make sure the thickness lever is set to the correct position 
for your media (see Chapter 3 for details).

◗ Turn off High Speed mode in the printer software (see 
Chapter 2 for details).

◗ Make sure you’re not using an Economy option in the 
printer software (see Chapter 2 for details).

◗ Replace the ink cartridges. (Check the status of the 
Ink Out B and Ink Out A lights first. See Chapter 6 for 
instructions.)

Here are some detailed solutions to specific print quality 
problems.

Printed image has horizontal banding.

Possible cause Solution

The Media Type setting 
doesn’t match the loaded 
paper.

Make sure the Media Type setting matches the loaded paper or 
other media. Then the printer software can automatically select 
other settings for the best quality. See Chapters 1 through 3.

The printable side of the 
paper is loaded upside 
down.

Remove the paper and reload it correctly for the media and feeder 
you’re using. See Chapter 3 for instructions.

The print head nozzles are 
clogged.

Clean the print heads. See Chapter 6 for instructions.

The ink cartridges are low 
on ink.

Check the Ink Out B and Ink Out A lights to see which cartridge 
you may need to replace. See Chapter 6.

The MicroWeave option is 
not set.

Turn on MicroWeave in the printer software. See Chapter 2 for 
more information.
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Vertical lines are misaligned or vertical banding appears.

The printed image has incorrect or missing colors.

Possible cause Solution

The print head nozzles are 
clogged.

Clean the print heads. See Chapter 6 for instructions.

High Speed mode or Bi-D 
mode are turned on.

If vertical lines are misaligned, turn off High Speed mode in the 
printer software (see Chapter 2 for information). If you’re printing 
with DOS, turn off Bi-D printing using default-setting mode (see 
Chapter 5 for instructions).

The print heads are 
misaligned.

Run the Print Head Alignment utility. See Chapter 6 for Windows 
or Macintosh instructions; see Chapter 5 for DOS instructions.

Possible cause Solution

The Ink option is set to 
Black.

Change the Ink setting to Color. See Chapter 1 for instructions.

The Media Type setting 
doesn’t match the loaded 
paper.

Make sure the Media Type setting matches the paper or media 
you’re using. Then the printer software can automatically select 
other settings for the best quality. See Chapters 1 through 3.

The printable side of the 
paper is loaded upside 
down.

Remove the paper and reload it correctly for the media and feeder 
you’re using. See Chapter 3 for instructions.

The Halftoning and Color 
Adjustment Mode 
options are set incorrectly 
for your document type.

Use the correct settings for the project you are printing, following 
the instructions in Chapter 2.

The print head nozzles are 
clogged.

Clean the print heads. See Chapter 6 for instructions.

The ICM (Windows 95) or 
ColorSync (Macintosh) 
settings are incorrect for 
your document.

Use the Automatic mode setting or choose a different project 
type setting. See Chapter 2 for more information.

The ink cartridges are low 
on ink or one or more ink 
colors are empty.

Check the Ink Out B and Ink Out A lights to see which cartridge 
you need to replace. See Chapter 6 for instructions.
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The printed image is faint or has gaps.

The printed image is blurry or smeared.

The colors displayed on 
your monitor don’t match 
the printed colors.

Because your monitor and printer use different technologies to 
represent colors, your printed colors cannot exactly match those 
on your monitor screen. Use the ICM (Windows 95) or ColorSync 
(Macintosh) settings. See Chapter 2 for more information.

The color settings in your 
application software need 
adjustment.

You may be able to adjust various color settings in your application 
software. See your software documentation for more information.

Possible cause Solution

The print head nozzles are 
clogged.

Clean the print heads. See Chapter 6 for instructions.

The Media Type setting 
doesn’t match the loaded 
paper.

Make sure the Media Type setting matches the loaded paper or 
other media. Then the printer software can automatically select 
other settings for the best quality. See Chapters 1 through 3.

The loaded paper is upside 
down, damaged, old, or 
dirty.

Remove the paper and reload a new stack with the printable side 
facing correctly. See Chapter 3 for instructions.

The ink cartridges are low 
on ink.

Check the Ink Out B and Ink Out A lights to see which cartridge 
you need to replace. See Chapter 6 for instructions.

You’re on a network and 
the Network I/F setting is 
turned off.

Try turning on the Network I/F setting using default-setting mode 
to see if this solves the problem. See Chapter 5 for instructions. 

Possible cause Solution

The printer’s thickness 
lever is in the 0 position.

Set the thickness lever to the + position and try printing again. See 
Chapter 3 for instructions.

The paper is damp or the 
printable side is upside 
down.

Remove the paper and reload a new stack with the printable side 
facing correctly. See Chapter 3 for instructions.

You loaded special media 
without a support sheet.

Follow the special media loading instructions in Chapter 3 and on 
the paper packaging for media that require support sheets. Also try 
loading your media one sheet at a time.

You tried to print on 
cardboard or other 
non-recommended media.

Make sure your paper or media meets the specifications listed in 
Appendix C. If your printouts are still blurry after you change paper, 
clean the print heads as described in Chapter 6.

Possible cause Solution
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Photographic images look grainy or rough.

Color documents print in black ink only.

The Media Type setting 
does not match the loaded 
paper.

Make sure the Media Type setting matches the media you loaded. 
Then the printer software can automatically select other settings 
for the best quality. See Chapters 1 through 3 for information.

The sheets entering the 
output tray are smearing 
the ink on ejected pages.

Remove each sheet from the output tray as soon as it is printed to 
prevent smearing, especially if you use transparencies. 

Ink has leaked inside the 
printer.

Clean carefully inside the printer to remove spilled ink. See 
Chapter 6 for instructions.

The color ink cartridge is 
empty and you’ve 
continued printing with the 
Ink option set to Color.

Follow the instructions on page 6-7 to print in black ink with an 
empty color cartridge. Then replace the color ink cartridge 
following the instructions in Chapter 6.

You’re using the High 
Speed (or BiD) and 
MicroWeave settings with 
a misaligned print head.

Turn off High Speed mode following the instructions in Chapter 2. 
(If you’re printing with DOS, turn off Bi-D printing in default-setting 
mode; see Chapter 5.) Then align the print heads following the 
instructions in Chapter 6 (for Windows and Macintosh) or 
Chapter 5 (for DOS).

Possible cause Solution

The print heads are 
misaligned.

Align the print heads following the instructions in Chapter 6 (for 
Windows and Macintosh) or Chapter 5 (for DOS).

The resolution of your 
image may be too low.

Increase the image resolution using your image-editing software, 
or decrease the size of the image.

Possible cause Solution

Your printer is not selected 
in your application.

Select your printer and port in your software application.

Color printing is not 
selected.

Select color printing in your application and the printer software 
(see Chapter 1).

Your color ink cartridge is 
empty.

Check the Ink Out A light and replace the color cartridge, if 
necessary. See Chapter 6 for instructions on replacing ink 
cartridges and printing with an empty color cartridge.

Possible cause Solution
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Solving Printing Problems
If the printer won’t print, first check that:

◗ The printer is turned on and the Operate light is on.

◗ Paper is loaded in the printer.

◗ The printer is securely plugged into a working electrical 
outlet that’s not controlled by a switch or timer.

◗ The interface cable is securely connected to the printer and 
computer. 

If you still can’t print, check the following solutions.

All lights are off.

Only the Operate light is on, but nothing prints.

Possible cause Solution

The printer is not receiving 
power.

Turn off the power and plug in the power cord securely, making 
sure the outlet is not controlled by a switch or timer and is 
operable.

Possible cause Solution

The interface cable is not 
connected securely.

Turn off your printer and computer. Then make sure the cable is 
connected securely and meets both the printer and computer 
specifications. See Appendix C and your computer documentation 
for information.

The printer has an internal 
problem.

Turn off the printer and computer, disconnect the interface cable, 
and run a printer self test as described on page 7-1.

Your printer or application 
software is installed 
incorrectly.

If the self test prints correctly, check your printer and application 
software for correct installation. If you’re printing on a network, 
make sure you set up your printer as described in Chapter 4.

Your computer doesn’t 
have enough memory to 
handle the data in the file 
you are printing.

Try one of the following:
◗ Reduce the resolution of your image.
◗ Select fewer colors or a lower resolution for your monitor.
◗ Add more memory to your computer.

Printing is stalled in 
Spool Manager 
(Windows 95/3.1) or the 
Windows NT print queue.

Delete the stalled print jobs in Spool Manager or the Windows NT 
print queue and resume printing. See Chapter 4 for instructions.
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The Paper Out light is flashing or on.

An Ink Out B or Ink Out A light is flashing or on.

All the lights come on briefly, then go off.

Printing is stalled in 
Monitor2 (Macintosh).

Open the Extensions folder, EPSON folder, and Spool folder. Then 
delete any queued files.

The print heads are clogged 
or the ink cartridges are too 
old.

If the printer sounds like it’s trying to print but nothing prints, clean 
the print heads; see Chapter 6 for instructions.

If cleaning doesn’t help, replace the cartridges. For information on 
cartridge life and replacement instructions, see Chapter 6.

You’re using an 
incompatible optional 
interface card or one with 
mismatched settings.

Check the specifications for your interface card and cable, making 
sure they meet the printer’s requirements (see Appendix A) and 
that they match your computer’s settings (see your computer 
manual). Also try turning on the Network I/F setting in 
default-setting mode if you’re sharing the printer (see Chapter 5). 

Possible cause Solution

If flashing, paper is 
jammed.

Remove the paper and follow the guidelines for preventing jams 
on page 7-15.

If on, paper is not loaded or 
is loaded incorrectly, or the 
paper release lever is set 
incorrectly.

Load paper, or remove the paper and reload it as described in 
Chapter 3, making sure to set the paper release lever correctly. 
Then press the Load/Eject button to turn off the light and resume 
printing.

Possible cause Solution

If flashing, the ink supply is 
getting low.

You need to replace the indicated ink cartridge soon. Make sure 
you have a new cartridge, then see Chapter 6 for instructions.

If on, the ink cartridge is 
empty.

You must replace the indicated ink cartridge; see Chapter 6 for 
instructions.

Possible cause Solution

The printer’s voltage 
doesn’t match your outlet’s 
voltage.

Check the label on the back of your printer to determine its 
voltage. If it doesn’t match your outlet’s voltage, turn off the 
printer and unplug it immediately. Then contact your dealer. 
Do not plug the printer back in.

Possible cause Solution
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All the lights are flashing.

The printer has finished charging an ink cartridge, but the Pause light is still 

flashing.

The printer sounds like it’s printing but nothing prints.

The printer software installed with Windows 3.1 does not work correctly after you 

upgrade to Windows 95.

After you install your printing software, you see the Windows 95 New Hardware 

Found window.

Possible cause Solution

An internal error may have 
occurred. 

Turn off your printer, wait five seconds, and turn it on again. If the 
lights still flash or stay on, contact EPSON as described in the 
Introduction.

Possible cause Solution

The ink cartridge clamp isn’t 
locked down.

Press down on the clamp to lock it into place.

The printer needs to 
initialize.

If the printer is not moving or making noise, but the light is still 
flashing after 10 minutes, turn the printer off. If the light is still 
flashing when you turn it back on, contact EPSON as described in 
the Introduction.

Possible cause Solution

The print head nozzles are 
clogged.

Clean the print heads. See Chapter 6 for instructions.

The ink cartridges are too 
old.

For information on cartridge life and replacement instructions, see 
Chapter 6.

The printer is charging ink. If you just turned on the printer, it may be charging the ink delivery 
system, especially if it has been turned off for a while. This can 
take up to 7 minutes; wait until it finishes before printing.

Possible cause Solution

Your printer software isn’t 
set up for Windows 95.

Reinstall the printer software after installing Windows 95, as 
described in the Quick Setup booklet.

Possible cause Solution

An operating system error 
has occurred.

Click Do not install a driver, and then click OK.
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You see a spooling error message (Windows 95/3.1).

In Windows 95, the Status Monitor box does not appear with the Despooler.

A portion of your image doesn’t print or you see a memory error message 

(Macintosh).

Your printer switches to the modem port or won’t confirm on the printer port 

(Macintosh).

Possible cause Solution

Spooling error messages or 
very slow printing may be 
caused by temporary files.

Change the Spool Manager default directory, following the 
instructions in Chapter 4.

Your hard drive is too full. Delete unnecessary files to make room on the drive.

Your computer doesn’t 
have enough memory for 
the file you’re printing.

Try one of the following:
◗ Reduce the resolution of your image.
◗ Select fewer colors or a lower resolution for your monitor.
◗ Add more memory to your computer.

Possible cause Solution

The Windows Print 
Manager is interfering with 
the Status Monitor.

Make sure Use Print Manager for this port is not checked in the 
Spool Manager Queue setup. See Chapter 4 for instructions.

Possible cause Solution

Your system doesn’t have 
enough available memory.

Close any other applications you are running or turn off 
background printing.

You may need to increase 
the memory allocation for 
your application, EPSON 
Monitor2, or both.

Choose Get Info from the File menu when your application is 
active and increase the memory requirements. See Chapter 4 for 
more information. Or turn off background printing (you won’t be 
able to use Monitor2).

Possible cause Solution

Your system has extension 
conflicts.

Make sure AppleTalk is inactive. In the Extensions Manager, 
disable the AppleShare, FileShare, and PrinterShare extensions. 
Set your printer and any unused printers to the printer port. Then 
restart your system.

You’re using an AppleTalk 
cable.

Make sure you’re using a standard Apple System Peripheral-8 
cable. See the specifications in Appendix C.

trouble.fm5  Page 11  Friday, May 9, 1997  2:11 PM



Troubleshooting

7-12

The “Sorry, EPSON Stylus COLOR cannot be used” message appears (Macintosh).

Your printer icon doesn’t appear in the Chooser (Macintosh).

Printing is too slow.

Possible cause Solution

The printer software has 
been corrupted.

Remove and reinstall the printer software. From the CD-ROM or 
diskette, click Installer. Then click Continue and select Custom 
Remove from the list displaying Easy Install. Select EPSON 
Stylus Series Printer Driver and click Remove. Click Continue, if 
necessary, and click Restart. Then follow the instructions in the 
Quick Setup booklet to reinstall the printer software and select 
your printer.

Then, in the Extensions Manager, disable Quick Draw GX, enable 
EPSON Monitor2 and EPSON Stylus Color, and restart your 
Macintosh.

Possible cause Solution

Your system has extension 
conflicts.

In the Extensions Manager, disable Quick Draw GX, enable 
EPSON Monitor2 and EPSON Stylus Color, and restart your 
Macintosh.

Possible cause Solution

Your printer software 
options are set incorrectly.

For the fastest printing, try these settings (described in Chapters 1 
and 2):
◗ Set Print Quality to Economy.
◗ Turn High Speed on.
◗ Choose Black ink.
◗ Choose No Halftoning.

Your system doesn’t have 
enough resources.

◗ Reduce the resolution of your image.
◗ Clear more hard disk space or run a defragmentation utility.
◗ Don’t run too many applications at the same time.
◗ Turn off virtual memory.
◗ Increase your system’s memory (RAM).

You’re using background 
printing on a Macintosh.

Choose Get Info from the File menu when your application is 
active and increase the memory requirements. See Chapter 4 for 
more information. Or turn off background printing (you won’t be 
able to use Monitor2).

Your Spool Manager 
settings are incorrect 
(Windows 95/3.1).

Change your default spool directory and other settings as 
described in Chapter 4.
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Fixing Paper Problems
You can avoid most paper handling problems by doing the 
following:

◗ Use smooth, high-quality media designed for ink jet 
printers that meet the media specifications in Appendix C.

◗ Make sure the paper is dry and flat before loading it.

◗ Follow all loading and handling instructions included with 
the media and in Chapter 3.

If you have problems with paper feeding, paper jams, or ejected 
paper, check here for solutions.

Paper doesn’t feed correctly from the sheet feeder.

Try this Then do this

Remove the stack of paper 
from the sheet feeder.

Check that the paper isn’t:
◗ Curled or creased.
◗ Too thick or thin (see Appendix C).
◗ Too old (see Chapter 3 or your paper packaging).
◗ Overloaded in the feeder (see Chapter 3 for guidelines).
◗ Jammed inside the printer. (If the Paper Out light is flashing, 

paper is jammed. See page 7-15.)
Then reload the paper as described in Chapter 3, making sure that:
◗ The paper release lever is set to the single sheet position.
◗ The edge guides fit the paper’s width snugly, but not too 

tightly.
◗ No continuous paper is in the paper path. (Press Load/Eject to 

park it out of the way.)
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Paper doesn’t feed correctly from the manual feeder.

Paper doesn’t feed correctly from the tractor feeder.

Try this Then do this

Remove the paper from the 
manual feeder.

Check that the paper sheet isn’t:
◗ Curled or creased.
◗ Too thick or thin (see Appendix C).
◗ Too old (see Chapter 3 or your paper packaging).
◗ Jammed inside the printer. (If the Paper Out light is flashing, 

paper is jammed. See page 7-15.)
Then reload the paper as described in Chapter 3, making sure that:
◗ The paper release lever is set to the single sheet position.
◗ The edge guides fit the paper’s width snugly, but not too 

tightly.
◗ The paper is loaded all the way into the printer.
◗ No continuous paper is in the paper path. (Press Load/Eject to 

park it out of the way.)

Try this Then do this

Remove the continuous 
paper from the tractor 
feeder following the 
instructions on page 3-18.

Check that the paper isn’t:
◗ Curled or creased.
◗ Too thick or thin (see Appendix C).
◗ Too old (see Chapter 3 or your paper packaging).
◗ Jammed inside the printer. (If the Paper Out light is flashing, 

paper is jammed. See page 7-15.)
Then reload the paper as described in Chapter 3, making sure that:
◗ The paper release lever is set to the continuous paper position.
◗ The paper stack is close enough to the printer, but has room in 

front and back to load and eject without obstruction.
◗ The paper’s holes are aligned on the sprockets, the sprockets 

are locked and their covers are closed, and the paper is not too 
slack.

◗ No single sheet paper is in the paper path. (Press Load/Eject to 
eject any sheets.)

Before printing, check that:
◗ The paper source and paper size are set correctly in your 

application or printer software. If you’re using DOS, check the 
Page Length setting in default-setting mode (see Chapter 5).

◗ The skip over perforation, auto tear-off, and banner modes are 
set correctly for your media (see Chapter 5).
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Multiple pages feed at the same time.

Paper jams inside the printer.

Paper doesn’t eject fully or is wrinkled.

Try this Then do this

Remove the stack of paper. ◗ Make sure the paper isn’t too thin (see the paper specifications 
in Appendix C).

◗ Fan the edges of the stack of paper to separate the sheets.
◗ Reload the paper as described in Chapter 3, making sure to 

load only the amount of paper directed for your media and 
feeder.

◗ If more copies of a page or document are printing than you 
expected, check that the Copies settings in both the printer 
software and your application program are set to 1. See 
Chapters 1 and 2 for information.

Try this Then do this

Turn off your printer, open 
the cover, remove any 
loaded paper, and remove 
any little pieces that may 
have torn off inside. 

You may need to turn the knob on the left side of the printer 
counterclockwise to eject all the torn pieces of paper. Never turn 

this knob when the printer is on. You’ll damage the printer 

and lose the top-of-form position.

Then reload the paper as described in Chapter 3.

If your paper jams frequently, make sure you:
◗ Use smooth, high-quality paper, with the printable side loaded 

correctly for your media type and feeder.
◗ Fan the stack and then even the edges before loading it.
◗ Don’t load too much paper for your media type and feeder.
◗ Adjust the edge guides or sprockets to fit the width of your 

paper snugly, but not too tightly.

Possible cause Solution

If the paper doesn’t eject 
fully, you may have set the 
wrong paper size.

Press the Load/Eject button to eject the paper. Then make sure 
you select the correct paper size in your application software, 
printer software, or default-setting mode. (See the paper 
specifications in Appendix C for the paper sizes you can print with.)

If it’s wrinkled when it 
comes out, the paper may 
be damp or too thin.

See the paper specifications in Appendix C for paper thicknesses 
you can print with, as well as environmental requirements for 
storage.
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Solving Miscellaneous Printout 
Problems
If your printout results are not what you expected, try these 
solutions.

Characters are incorrect or garbled.

.

Possible cause Solution

Your printer is not the 
Windows default printer.

Select your printer as the default Windows printer. See your 
Windows documentation or online help for instructions.

Your printer is not selected 
in the Macintosh Chooser.

Open the Chooser and select your printer. See the Quick Setup 
booklet for instructions.

Your printer is not selected 
in your DOS applications.

Select printer software for each DOS application you use, as 
described in Chapter 5.

Printing is stalled in 
Spool Manager 
(Windows 95/3.1) or in the 
Windows NT print queue.

Delete the stalled print jobs in Spool Manager or the Windows NT 
print queue following the instructions in Chapter 4. Then try 
printing again.

If you’re using background 
printing on a Macintosh, 
spooled data may be 
corrupted.

Open the Extensions folder, EPSON folder, and Spool folder. Then 
delete any queued files. Increase the memory requirements for 
EPSON Monitor2 as described in Chapter 4.

The interface cable is not 
securely connected.

Turn off your printer and computer. Then make sure the cable is 
connected securely and meets the printer’s specifications.

You’re printing with DOS 
and your software or 
default-setting mode 
settings are incorrect.

If you selected your font, pitch, character table, and line spacing 
settings in your application software, make sure those settings are 
correct. If you set them using your printer’s default-setting mode 
(along with the Network I/F setting), follow the instructions in 
Chapter 5 to make sure those settings are correct.

The printer’s parallel 
interface transfer rate 
doesn’t match your 
computer’s transfer rate.

Set the Parallel I/F transfer rate option to Normal using 
default-setting mode. See Chapter 5 for instructions.
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The margins are incorrect.

The image is inverted as if viewed in a mirror.

The printer prints blank pages.

Possible cause Solution

Margins are set incorrectly 
in your software 
application.

Check your software documentation for instructions on selecting 
the correct margins for your paper size. The maximum printable 
width is 13.6 inches (345 mm) on any size paper.

Make sure the margins are within the printable area of the page. 
See Appendix C for more information.

Paper settings in the printer 
software are incorrect for 
your paper size.

Select the correct paper settings for your paper size. See 
Chapters 1 and 2 for more information.

The edge guides or 
sprockets are set 
incorrectly.

The edge guides or sprockets in the paper feeder are set 
incorrectly for your paper’s width. See the instructions in 
Chapter 3. You may also need to adjust the margins in your 
software application to match the new loading position.

Possible cause Solution

You used a Flip Horizontal 
option in your application 
software or the printer 
software.

Turn off the Flip Horizontal or mirror setting in your application 
software or the printer software. See Chapter 2 for information. 
Remember that images printed on iron-on transfer paper and back 
light film should be inverted so they appear correctly when 
transferred or viewed from the reverse side.

Possible cause Solution

The print head nozzles are 
clogged.

Clean the print heads following the instructions in Chapter 6.

Paper settings in the printer 
software are incorrect for 
your paper size.

Select the correct paper settings for your paper size. See 
Chapters 1 and 2 for more information.

Your printer is not the 
Windows default printer.

Select your printer as the default Windows printer. See your 
Windows documentation or online help for instructions.

Your printer is not selected 
in the Macintosh Chooser.

Open the Chooser and select your printer. See the Quick Setup 
booklet for instructions.
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A
Your EPSON Stylus COLOR 1520 includes both parallel and 
serial interfaces so you can connect it to a PC or Macintosh, or 
both at the same time. If you want to connect to another system 
or to a network, you can install an optional interface board. 

You can install one of the following EPSON interface boards in 
your printer:

To order an interface board, contact your dealer or call EPSON 
Accessories at (800) 873-7766 (U.S. sales only). In Canada, call 
(800) 873-7766 for dealer referral. 

This chapter tells you how to install and use EPSON interface 
boards in the following sections:

◗ Using Macintosh interface boards

◗ Using the PC serial interface board

◗ Installing optional interfaces

Using Optional
Interfaces

Type of interface board Model number Compatibility

Serial C823051 PC

32KB serial C832071 PC

32KB parallel C823101 PC

Twinax C823151 PC

Coax C823141 PC

LocalTalk C823121 Macintosh

Ethernet C823461 Macintosh/PC 

Type B bidirectional 
parallel

C823452 PC
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Using Macintosh Interface Boards
If you are planning to install the LocalTalk board, you also need 
two LocalTalk Locking Connector Kits (DIN-8 version). 
Attach one connector box to the AppleTalk interface on the 
printer and the other to the printer port on the Macintosh. 
Then attach the LocalTalk cable between the two connector 
boxes. For more information, see the instructions that come 
with the connector kits.

If you install the Ethernet board connected to a thin coaxial 
(10BASE2) cable, and the printer is the last device on the 
network, you need to obtain a 50-ohm terminator. The 
Ethernet transceiver is included on the EPSON Ethernet board, 
so you don’t need an adapter box for the printer. 

Using the PC Serial Interface Board
Before you install the serial interface board in your printer, 
follow the instructions that come with the board for setting the 
baud rate and parity. You may also need to set the board’s 
handshake timing, error handling, and other data transfer 
conventions. Refer to your computer documentation for 
information about matching the board’s settings to your 
computer system. 

Installing Optional Interfaces 
Before you install an optional interface board in your printer, 
make sure the printer is turned off and all the printer’s lights are 
off. Then follow these steps:

1. Unplug the power cord from the electrical outlet (and from 
the back of the printer, if your printer’s power cord is 
removable).

Caution:
To avoid damaging your 
printer or computer, do 
not install the interface 
board when the printer is 
connected to an electrical 
outlet. 
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2. Disconnect any interface cables from the back of the 
printer.

3. Use a Phillips-head screwdriver to remove the two screws 
securing the interface cover. Then lift off the cover. 

4. Set any switches and jumpers on the interface board as 
described in its manual. If your board has a jumper labeled 
JG, make sure that you set it to ON, or the board will not 
work properly.

5. Slide the interface board along the slots on both sides of the 
compartment. Push it in firmly to fully insert the board’s 
connector into the printer’s internal socket.

6. Secure the interface board in the slot with the two screws 
included with the board.
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7. Connect the proper interface cable to the interface board 
and to your computer. If the cable has a grounding wire, 
connect it to one of the screws securing the interface board.

8. Reconnect any other interface cables you disconnected.

9. Make sure the printer is turned off. Then plug in the power 
cord and turn on the printer.

In most cases, the printer automatically detects the interface 
you’re using. However, if you have trouble printing through an 
installed interface board, you may need to change the printer’s 
I/F (interface) mode setting using default-setting mode. See 
page 5-3 for instructions. 

To remove the interface board, first follow steps 1 and 2 in this 
section. Remove the screws securing the board and carefully 
pull it out of the internal printer socket. Then replace the 
interface cover and screws you removed in step 3. Now you can 
connect your printer using one of the built-in interfaces as 
described in your Quick Setup booklet.
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B
You can use the EPSON Plot! program to open and scale HPGL 
or HPGL/2 plotter files and then print them on your printer. 
Follow the instructions in this Appendix to install the program 
and print with EPSON Plot! and your Windows printer driver.

You can install and use EPSON Plot! on any system running 
Windows 3.1, Windows 95, or Windows NT (3.51 or 4.0). 
Make sure to connect the printer to that system and install the 
printer software following the instructions in the Quick Setup 
booklet before you begin.

Installing EPSON Plot!
Follow these steps to install EPSON Plot! on the system 
connected to the printer:

1. Make sure Windows is running, but no applications are 
open.

2. Insert the EPSON Plot! Disk 1 diskette in a drive.

3. With Windows 3.1 or Windows NT 3.51 Program 
Manager, open the File menu and click Run.

With Windows 95 or Windows NT 4.0, click Start, then 
click Run.

4. Type A:\SETUP or B:\SETUP and click OK.

Using
EPSON Plot!

Note:
You can also install 
EPSON Plot! from the 
printer software 
CD-ROM.
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5. Follow the instructions on the screen to install the program 
on your hard disk.

The installation program creates an EPSON Plot! program 
group or folder containing the program icon and icons for 
Help, Readme, and Uninstall programs.

Printing with EPSON Plot!
Before starting EPSON Plot!, do the following to prepare for 
printing:

◗ Install the EPSON Stylus COLOR 1520 Windows printer 
software on the computer connected to the printer. (See the 
Quick Setup booklet for instructions.)

◗ Turn on the printer.

◗ Create an HPGL or HPGL/2 plot file using your plotter 
software on any system.

◗ Copy that plot file to the system connected to the printer, if 
necessary.

Now follow these steps to open EPSON Plot! and print:

1. Double-click the EPSON Plot! icon in the EPSON Plot! 
program group or folder. You see the following screen:

Note:
When you create plot 
files for printing, use an 
HPGL/2 driver whenever 
possible. HPGL/2 drivers 
do a better job of 
maintaining the colors 
assigned in your CAD 
application than HPGL 
drivers, which may limit 
you to 8 or 16 pen colors.
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2. Select Open File from the File menu.

3. In the Open File dialog box, choose the HPGL or HPGL/2 
file you want to print and click OK. A representation of the 
file contents appears in the Live Paper Space in EPSON 
Plot!:

4. Select Printer Setup from the File menu.

5. Select the EPSON Stylus COLOR 1520 printer, if necessary, 
and click Options. You see the Main printer settings menu.

6. Follow the instructions in Chapters 1 and 2 to select the 
correct printer settings. Make sure to select the Paper 
Source and Paper Size options for your paper and feeder 
so EPSON Plot! can display the plot file contents exactly as 
it will appear when you print. 

7. When you’re finished selecting your printer software 
settings, click OK. Then click OK in the Printer Setup 
dialog box. 

8. If you want to resize the plot file, click a handle in the Live 
Paper Space and drag it to change the size. To reposition 
the plot, click inside the image display and drag it into 
position.

live paper 
space

handle

Note:
The gray area around the 
image represents the 
area you cannot print on.

If you resize the plot file, 
EPSON Plot! retains the 
proportions of the 
original and preserves the 
X and Y coordinates.

Keep in mind that the 
Print Quality (resolution) 
you select in the printer 
software may resize your 
image differently than it is 
displayed in EPSON Plot!.
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9. When the plot file looks how you want it to, select Print 
from the File menu.

10. Click OK to print the file on your EPSON Stylus COLOR 
1520.

See Chapters 1 and 4 for information on managing the 
print job while it prints. 

11. When you’re finished printing with EPSON Plot!, select 
Exit from the File menu to exit the program.
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C
Printing

Printing method On-demand ink jet

Nozzle configuration Monochrome (black) 128 nozzles 
Color (cyan, magenta, yellow) 192 nozzles, 64 of each color

Printable columns and 
printing speeds

cps = characters per second
 

Resolution Maximum 1440 dpi × 720 dpi

Print direction Bidirectional with logic seeking for text and graphics. (Auto print 
direction can be set in default-setting mode.)

Control code ESC/P 2 and expanded raster graphics code
IBM XL24E emulation

Line spacing Default is 1/6 inch, programmable in 1/8-inch or 1/360-inch 
increments

Paper feed speed 107 milliseconds per 1/3-inch line 

Input buffer 64KB

Specifications

Character pitch 

(characters per inch) Printing column

Draft printing 

speed

LQ printing 

speed

10 136 800 cps 400 cps

12 163 960 cps 480 cps

15 204 1200 cps 600 cps

17 (10 condensed) 233 1378 cps 684 cps

20 (12 condensed) 272 1600 cps 800 cps
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Fonts

Select other font/pitch combinations using the ESC/P 2 commands as 
described on page 5-17.

Note: 
The printer always uses the fonts you selected with your software application. You need to use the 
printer’s internal fonts only if your application doesn’t allow you to select fonts.

Character tables 1 italic and 26 graphics character tables

Character sets 14 international character sets and 1 legal character set

Note:
Character tables are selected with default-setting mode (see page 5-3 for instructions) or by using 
software commands (see page 5-17 for instructions).

Bitmap fonts
Font 10 cpi 12 cpi 15 cpi Proportional

EPSON Roman x x x x

EPSON Sans Serif x x x x

EPSON Courier x x x —

EPSON Prestige x x x —

EPSON Script x x x —

Scalable fonts

Font

Minimum 

point size

Maximum 

point size Increments

EPSON Roman 8 32 2

EPSON Sans Serif 8 32 2

EPSON Roman T 8 32 2

EPSON Sans Serif H 8 32 2
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Paper 

Paper type Size Paper types Thickness Weight

Single sheets Letter (8.5 × 11 inches) 
A4 (210 × 297 mm)
A5 (148 × 210 mm)
Legal (8.5 × 14 inches) 
Half Letter (5.5 × 8.5 inches)
Executive (7.5 × 10 inches)
A2 (420 × 594 mm)
Super A3/B (13 × 19 inches)
A3 (297 × 420 mm)
Ledger (11 × 17 inches)
US C (17 × 22 inches)
B3 (364 × 514 mm)
B4 (257 × 364 mm)
B5 (182 × 257 mm)

Plain bond paper and 
special ink jet papers 
distributed by 
EPSON

0.0025 to 0.004 inch 
(0.065 to 0.11 mm) 

Built-in sheet 
feeder:
17 to 24 lb 
(64 to 90 g/m2)
Manual feeder:
14 to 24 lb 
(52 to 90 g/m2)

Continuous 
paper

Minimum size each sheet:
4 to 16 inches × 4 inches
(101.6 to 406.4 × 101.6 mm)

Plain paper 0.0025 to 0.0039 inch
(0.065 to 0.1 mm)

14 to 22 lb 
(52 to 82 g/m2)

Transparencies 
and glossy film

Letter (8.5 × 11 inches)
A4 (210 × 297 mm)
A6 (105 × 148 mm, glossy 
film only)
Super A3/B (13 × 19 inches, 
glossy film only)

Transparencies and 
glossy film 
distributed by 
EPSON

0.005 to 0.006 inch 
(0.13 to 0.15 mm)

—

Glossy paper Letter (8.5 × 11 inches)
A2 (420 × 594 mm)
A4 (210 × 297 mm)
Super A3/B (13 × 19 inches)

Glossy paper 
distributed by 
EPSON

0.0066 to 0.0070 inch 
(0.17 to 0.18 mm)

—

Self adhesive 
sheets

A4 (210 × 297 mm) Self adhesive sheets 
distributed by 
EPSON

0.0079 inch (0.2 mm) 
maximum 

—

Envelopes No. 10 9.5 × 4.1 inches 
(240 × 104 mm) 

DL 8.7 × 4.3 inches 
(220 × 110 mm) 

C5 6.4 × 9 inches 
(162 × 229 mm)

Plain bond paper or 
air mail paper

0.006 to 0.02 inch 
(0.16 to 0.52 mm)

12 to 24 lb 
(45 to 90 g/m2)

Index cards A6 (105 × 148 mm)
8 × 10 inches (203 × 254 mm)

Ink jet cards 
distributed by 
EPSON

0.0091 inch (0.23 mm)
maximum

50 lb 
(188 g/m2)

Roll paper 8.3 to 17 inches × 49.2 ft
(210 to 432 mm × 15 m)

Roll paper 
distributed by 
EPSON

0.003 to 0.004 inch
(0.08 to 0.1 mm)

17 to 22 lb
(64 to 82 g/m2)

Back light film A2 (420 × 594 mm) Back light film 
distributed by 
EPSON

0.0051 to 0.0055 inch
(0.13 to 0.14 mm)

—
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Note: 
Since the quality of any particular brand or type of paper may be changed by the manufacturer at 
any time, EPSON cannot attest to the quality of any non-EPSON brand or type of paper. Always 
test samples of paper stock before purchasing large quantities or printing large jobs.

Poor quality paper may reduce print quality and cause paper jams and other problems. If you 
encounter problems, switch to a higher grade of paper.

Ink jet paper, envelopes, glossy film, glossy paper, transparencies, and self adhesive sheets are 
usable only under these conditions:

Temperature: 59 to 77 °F (15 to 25 °C)
Humidity: 40 to 60% RH

EPSON Photo Quality Glossy Film and Photo Quality Self Adhesive Sheets should be stored under 
these conditions:

Temperature: 59 to 86 °F (15 to 30 °C)
Humidity: 20 to 60% RH

Printable areas

Note:
The maximum printable width is 13.6 inches (345 mm) regardless of the paper size or feeder you 
use.

Single sheets and 
index cards

A: The minimum top margin is 0.12 inch (3.0 mm).

When loading multiple sheets of EPSON Photo Quality Glossy Film, 
the minimum top margin is 1.2 inches (30 mm).

BL: The minimum left margin is 0.12 inch (3.0 mm); except for A3 
landscape, A2 portrait, Ledger landscape, and US C portrait, which 
are 0.98 inch (25 mm).

BR: The minimum right margin is 0.12 inch (3.0 mm); except for A3 
landscape and A2 portrait, which are 2 inches (50 mm), and Ledger 
landscape and US C portrait, which are 2.4 inches (62 mm).

C: The minimum bottom margin is 0.55 inch (14.0 mm).

Paper type Size Paper types Thickness Weight

Continuous 
label paper

Minimum size each backing 
sheet:
4 to 16 inches × 4 inches
(101.6 to 406.4 × 101.6 mm)
Minimum label size:
2.5 × 0.94 inches
(63.5 × 23.9 mm)

Plain continuous 
label paper

Maximum total 
thickness:
0.0079 inch (0.2 mm)
Maximum label 
thickness:
0.0047 inch (0.12 mm)

—

A

BL
BR

C
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Envelopes
A: The minimum top margin is 0.12 inch (3.0 mm).

BL, BR: The minimum left and right margins are 0.12 inch (3.0 mm).

C: The minimum bottom margin is 0.55 inch (14.0 mm).

Continuous paper

A: The minimum top and bottom margins above and below the 
perforations are 0.35 inch (9.0 mm).

B: The minimum right and left margins are 0.51 inch (13 mm).

Ink Cartridges

* The print capacity may vary, depending on how often you clean the print head.

** It thaws and is usable after approximately 3 hours at 77 °F (25 °C).

Caution:
To ensure good results, use genuine EPSON ink cartridges. Other products may cause damage 
to your printer not covered by EPSON’s warranty.

Don’t use an ink cartridge if the date on the package has expired.

A

C
BL BR

A A

BB

Specification Black ink cartridge (S020108) Color ink cartridge (S020089)

Color(s) Black Cyan, Magenta, and Yellow

Print capacity* 900 pages/A4 (ISO/IEC 10561 Letter Pattern 
at 360 dpi)

300 pages (A4, 360 dpi, 5% duty each color)

Cartridge life 2 years from production date, if unopened
Within 6 months after opening package at 77 °F (25 °C)

Storage 
temperature

–4 to 104 °F (–20 to 40 °C)
1 month at 104 °F (40 °C)

Transit 
temperature

–22 to 140 °F (–30 to 60 °C)
1 month at 104 °F (40 °C)
120 hours at 140 °F (60 °C)

Freezing 
temperature**

3.2 °F (–16 °C) –0.4 °F (–18 °C)

Dimensions 1.1 (W) × 2.1(D) × 1.5 (H) inches
27.8 (W) × 52.7(D) × 38.5 (H) mm

1.7 (W) × 2.1(D) × 1.5 (H) inches
42.9 (W) × 52.7 (D) × 38.5 (H) mm
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Mechanical
Paper feed method Friction, tractor feeder

Paper path Sheet feeder, front entry
Manual feeder, rear entry
Tractor feeder, rear entry

Sheet feeder capacity 100 sheets of 17 lb (64 g/m2) paper
For detailed information, see Chapter 3.

Total print volume 75,000 pages (A3, text only)

Dimensions

Storage Width: 26.2 inches (666 mm) 
Depth: 13.1 inches (333 mm) 
Height: 8.0 inches (202 mm)

Printing Width: 26.2 inches (666 mm) 
Depth: 24.4 inches (619 mm) 
Height: 8.0 inches (202 mm)

Weight 33 lb (15 kg) without the ink cartridges

Electrical

Note: 

Check the label on the back of the printer for your printer’s voltage.

Environmental
Temperature Operation: 50 to 95 °F (10 to 35 °C)

Storage: –4 to 140 °F (–20 to 60 °C), stored in shipping container 
1 month at 104 °F (40 °C) 
120 hours at 140 °F (60 °C)

Humidity Operation: 20 to 80% RH
Storage: 5 to 85% RH (stored in shipping container, without 
condensation)

Specification 120V Model 220−240V Model

Input voltage range 103.5 to 132V 198 to 264V

Rated frequency range 50 to 60 Hz

Input frequency range 49.5 to 60.5 Hz

Rated current 0.7A 0.4A

Power consumption Approx. 21W (ISO/IEC 10561 Letter Pattern)
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Safety Approvals
Safety standards UL 1950 with D3, CSA C22.2 950 with D3

EMC FCC part 15 subpart B class B

Interfaces
Parallel interface

Forward channel Data format: 8-bit parallel, IEEE-1284 compatibility mode

Synchronization: STROBE pulse

Handshake timing: BUSY and ACKNLG signals

Signal level: TTL compatible

Connector: 57-30360 Amphenol connector or equivalent

Reverse channel Transmission mode: IEEE-1284 Nibble mode

Adaptable connector: 57-30360 Amphenol Connector or equivalent

Synchronization: Refer to the IEEE-1284 specification

Handshaking: Refer to the IEEE-1284 specification

Signal level: IEEE-1284 Level 1 device

Data transmission timing: Refer to the IEEE-1284 specification

Serial interface

Standard: Based on RS-423

Synchronization: Synchronous

Bit rate: Maximum 1.8 Mbps

Handshaking: X-ON/X-OFF, DTR protocol

Word format: 
Data bit: 8 bits
Parity bit: None
Start bit: 1 bit
Stop bit: 1 bit

Connector: 8-pin mini-circular connector

Recommended cable: Apple System Peripheral-8 cable (preferably 
Belkin brand)
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Glossary

banding The horizontal lines that sometimes appear when printing 
graphics. See also MicroWeave.

buffer The portion of the printer’s memory used to store data before 
printing it.

character table A collection of letters, numbers, and symbols that provides you 
with the characters used in a particular language.

characters per inch (cpi) A measure of the size of text characters, sometimes referred to as 
pitch.

CMYK Cyan (blue-green), magenta, yellow, and black. These colored 
inks are used to create the subtractive system array of printed 
colors.

ColorSync Macintosh software that is designed to help you get WYSIWIG 
(what you see is what you get) output. This software prints 
colors as you see them on your screen.

default A value or setting that takes effect when the equipment is 
turned on, reset, or initialized.

dithering A halftoning method in which dots are arranged in an orderly 
pattern. Dithering works best for printing images with solid 
colors, such as charts and graphs. See also halftoning.

dpi Dots per inch. The dpi measures the resolution. See also 
resolution.

driver A software program that sends instructions to a computer 
device to tell it what to do. For example, your printer driver 
accepts print data from your word processing application and 
sends instructions to the printer on how to print this data.
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Error Diffusion This halftoning setting smooths out edges by randomly placing 
dots of varying colors. 

ESC/P Abbreviation for EPSON Standard Code for Printers. This 
system of commands gives you control of your printer from 
your computer. It is standard for all EPSON printers and 
supported by most application programs for personal 
computers.

ESC/P 2 The enhanced version of the ESC/P printer command 
language. Commands in this language produce laser-like 
features, such as scalable fonts and enhanced graphics printing.

Finest Detail This printer driver setting automatically makes your printed 
images sharper and clearer. Be aware that this may increase the 
time required for printing.

font A style of type designated by a name.

grayscale A scale of shades of gray from black to white. Grayscale is used 
to represent colors when printing with black ink only.

halftoning A method of using dot patterns to represent an image. 
Halftoning makes it possible to produce varying shades of gray 
using only black dots, or a nearly infinite array of colors using 
only a few colors of dots.

initialization Returns the printer to its defaults (fixed set of conditions). This 
happens every time you turn on or reset the printer.

ink jet A method of printing in which each letter or symbol is formed 
by precisely spraying ink onto paper.

interface The connection between the computer and a peripheral such as 
a printer. Some printers have two interfaces, parallel and serial. 
A parallel interface transmits data one byte, or eight bits, at a 
time. A serial interface transmits data one bit at a time.

ips Inches per second. This scale is used to measure the printing 
speed.
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media Materials upon which data is printed, such as envelopes, plain 
paper, special paper, and transparencies.

MicroWeave Printing technology that produces images in fine increments to 
reduce the possibility of banding. See also banding.

monochrome This means printing with only one color of ink, which is 
generally black ink.

parallel interface See interface.

print queue Print jobs that are sent to the printer while it is busy are stored 
in a waiting line, or print queue, until they can be printed.

print server The computer connected to the printer. It receives the jobs and 
then distributes them to the assigned printer. It also holds extra 
print jobs while the printer is busy. See also print queue.

printable area The area of a page on which the printer can print. It is smaller 
than the physical size of the page due to margins. 

printer driver See driver.

proportional printing Printing in which the width of the character varies from 
character to character. For example, a capital W receives much 
more space than a lowercase i. The result looks more like a 
typeset book than a typewritten draft.

reset To return a printer to its defaults either by sending a command, 
an INIT signal or by turning the printer off and then back on.

resolution The number of dots per inch used to represent an image.

RGB Red, green, and blue. These colors, in phosphors irradiated by 
the computer monitor’s electron gun, are used to create the 
additive array of screen colors.

scalable fonts Fonts that can be enlarged or reduced. Non-scalable fonts are 
called bitmap fonts and can’t change in size.

screen pattern This feature prints shaded areas as they appear on screen, 
instead of printing them as halftones.
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serial interface See interface.

spool The process by which the printer driver converts the print data 
into codes that your printer understands. This data is then sent 
to the printer directly or to the print server.

Spool Manager An EPSON software program that converts print data into codes 
that your printer understands. See also spool.

Status Monitor An EPSON software program that displays the printer’s status, 
such as paper out or the amount of ink remaining before 
printing.

subtractive colors Colors produced by pigments that absorb some colors of light 
and reflect others. See also CMYK.
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Index

A Accessories, EPSON, 5
Adhesive sheets, see Self adhesive 

sheets
Adjusting

cut-off position, 3-31
loading position, 3-20
margins, 3-10, 3-13, 3-19
tear-off position, 3-21

Advanced mode, 2-1 to 2-3, 2-6
Advanced settings

custom, 2-4 to 2-13
predefined, 2-1 to 2-4

AGM setting, 5-6, 5-19
Aligning print heads, see Print head 

alignment
Assigning name to printer, 4-14
Auto

CR setting, 5-6
I/F wait time, 5-5
line feed setting, 5-6
tear-off, 3-14, 3-18, 

3-21 to 3-22, 5-3, 5-7
AutoCAD driver, 1, 5-1
Automatic color adjustment, 2-8
Automatic mode, 1-3, 1-10, 2-6, 

3-5

B Back light film
choosing, 3-3 to 3-4
printing on, 3-33 to 3-35
specifications, C-3

Background printing
Macintosh, 1-11, 4-6 to 4-7, 

7-12
PC, 4-1

Banding, 7-4 to 7-5
Banner mode, 3-22, 5-3, 5-7

Banners
choosing paper, 3-3 to 3-4
loading roll paper, 3-22 to 3-26
paper specifications, C-3
printing from Macintosh, 

3-29 to 3-30
printing from Windows, 

3-27 to 3-28
removing roll paper, 

3-30 to 3-33
Basic printing, 1-1 to 1-14
Blank pages, 7-17
Blurry printouts, 7-6 to 7-7
Brightness setting, 2-9
Built-in sheet feeder, see Sheet 

feeder
Buttons, control panel, 

1-13 to 1-14

C Cable cover, 3-15
Cancelling changes, printer 

software, 1-4, 1-9
Canvas cloth, see Ink Jet Canvas 

Cloth
Cards, see Ink jet cards
Character tables, 5-6, 5-8 to 5-17, 

C-2
Characters, incorrect or garbled, 

7-16
Cleaning

print heads, 6-1 to 6-4, 7-4
printer, 6-10
sheet, special media, 3-5

Coarse Dithering option, 2-6
Coax interface board, A-1
Collate setting, 1-4
Color

Adjustment modes, 2-8
characteristics, 2-9
problems, 7-5 to 7-6
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Colorimetric setting, 2-11
ColorSync, 2-3, 2-7, 2-10 to 2-11
Commands, printer, 5-17 to 5-19
Communication problems, 

7-2 to 7-3
CompuServe, 6
Continuous paper

choosing settings for, 3-3 to 3-5
printing on, 3-14 to 3-17
removing, 3-18 to 3-19
specifications, C-3 to C-5
switching to single sheets, 

3-21 to 3-22
Contrast setting, 2-9
Control codes, 5-17 to 5-19, C-1
Control panel

buttons, 1-13 to 1-14
default-setting mode, 

5-3 to 5-7, 7-16, C-2
lights, 1-13 to 1-14, 7-1, 

7-8 to 7-10
print head alignment, 6-9
print head cleaning, 6-3
using, 1-13 to 1-14, 7-1

Control Panels, Macintosh, 2-10
Current Settings box, 1-4, 1-11, 

2-4
Custom paper size, 3-28 to 3-30
Custom settings

color, 2-7 to 2-10
deleting, 2-12
print quality, 2-4 to 2-7
printing with, 2-1 to 2-13
project types, 2-3, 3-5
redefining, 2-13
saving, 2-11 to 2-12
special effects, 2-4 to 2-7

Customer Care Centers, EPSON, 
5

Cut-off position, 3-31
Cyan setting, 2-9

D Default printer options, setting, 
1-5 to 1-6

Default-setting mode, 5-3 to 5-7, 
7-16, C-2

Despooler, 1-4, 1-7 to 1-8, 4-5
Dithering options, 2-6
DOS

AutoCAD driver, 1, 5-1
changing printer settings, 

5-3 to 5-7
character tables, 5-6, 

5-8 to 5-17, C-2
EPCALIB utility, 5-7 to 5-8
maintaining printer, 5-7 to 5-8
printer commands, 

5-17 to 5-19
selecting printer software for, 

5-1 to 5-2
using printer with, 5-1 to 5-19

Download Service, EPSON, 6
Draft printing, 2-3, 2-5

E Economy settings, 2-3, 2-5, 7-4
Electrical specifications, C-6
Electronic support services, 

EPSON, 5 to 6
Empty color ink cartridge, printing 

with, 6-7, 7-7
Emulation, 5-6, 5-17 to 5-19
ENERGY STAR, 7
Energy-saving tips, 7
Envelopes

printing on, 3-3 to 3-5, 3-9, 
3-13

specifications, C-3 to C-4
Environmental specifications, C-4, 

C-6
EPCALIB utility, 5-7 to 5-8
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EPSON
Accessories, 5
Customer Care Centers, 5
Download Service, 6
Electronic support services, 

5 to 6
FaxAdvice, 6
help, 5 to 6
media, 3-2 to 3-4
World Wide Web site, 6

EPSON Namer utility, 4-14
EPSON Plot! utility, 1, B-1 to B-4
Error Diffusion option, 2-6
ESC ( ^ command, 5-17 to 5-18
ESC R command, 5-16 to 5-18
ESC/P 2, 5-1, 5-6, 5-16 to 5-18
Ethernet board, A-1 to A-2
Extension module, Power 

Macintosh, 1-11

F Faint printouts, 7-6
FaxAdvice, EPSON, 6
Film, see Photo Quality Glossy 

media
Fine Dithering option, 2-6
Finest Detail setting, 2-6
Flip Horizontal setting, 2-6, 3-4, 

3-34, 7-17
Fonts, 5-5, C-2

G Garbled characters, 7-16
Glossy media

choosing, 3-2 to 3-4
printing on, 3-5
specifications, C-3 to C-4

Graph project type, 2-3

H Halftoning setting, 2-6
Hard drive space, 2 to 3
Head Cleaning utility, 6-2
Help

EPSON, 5 to 6
online, 1-11 to 1-12

Hex dump, printing, 7-2 to 7-3
High Quality Ink Jet Paper

choosing, 3-2 to 3-4
printing on, 3-5
specifications, C-3 to C-4

High Speed setting, 2-6, 7-4 to 7-5
Horizontal banding, 7-4
HPGL files, printing, B-1 to B-4
Humidity, C-4, C-6

I I/F mode, 5-5, A-4
IBM XL24E emulation, 5-6, 5-19
ICM (Image Color Matching), 2-3, 

2-7 to 2-10
Improving print quality, 7-4 to 7-7
Incorrect

characters, 7-16
margins, 7-17

Index cards, see Ink jet cards
Ink

monitoring level, 1-7 to 1-8, 
4-5, 4-8

setting, 1-3, 1-11, 2-2, 2-5, 6-7
Ink cartridge

printing with empty color, 6-7
problems, 7-4, 7-7, 7-9 to 7-10
replacing, 6-4 to 6-7, 7-4
specifications, C-5

Ink Jet Back Light Film
choosing, 3-3 to 3-4
printing on, 3-33 to 3-35
specifications, C-3

Ink Jet Canvas Cloth
choosing, 3-3 to 3-4
printing on, 3-22 to 3-30
removing, 3-30 to 3-33
specifications, C-3

Ink jet cards
choosing, 3-2 to 3-4
printing on, 3-10
specifications, C-3 to C-4

Ink jet paper
choosing, 3-2 to 3-4
printing on, 3-5
specifications, C-3 to C-4
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Ink Jet Transparencies
choosing, 3-2 to 3-4
printing on, 3-5
specifications, C-3 to C-4

Input buffer, C-1
Interface (I/F) mode, 5-5, A-4
Interface boards

installing, A-2 to A-4
Macintosh, A-1 to A-2
parallel, A-1
problems, 7-9
removing, A-4
serial, A-1 to A-2
using, A-1 to A-4

Interface specifications, C-7
International character sets, 5-6, 

5-16, C-2
Iron-On Transfer Paper

choosing, 3-2 to 3-4
printing on, 2-6, 3-4

Italic character set, 5-15

J Jammed paper, 1-13, 7-9, 7-15

K Knob, printer, 3-20, 7-15

L Labels, 3-3, 3-14, 3-18 to 3-21, C-4
see also Self adhesive sheets

Landscape setting, 1-4, 1-9
Language, selecting, 5-3 to 5-4, 6-9
Legal-size paper, 3-6
Letterhead, 3-5
Lights, control panel, 1-13 to 1-14, 

7-1, 7-8 to 7-10
Line spacing, C-1
Loading position, adjusting, 3-20
LocalTalk board, A-1 to A-2

M Macintosh
background printing, 1-11, 

4-6 to 4-7, 7-12
ColorSync, 2-3, 2-7, 

2-10 to 2-11
Control Panels, 2-10
interface boards, A-1 to A-2
interface specifications, C-7
managing print jobs from, 

4-6 to 4-8
network printing, 4-13 to 4-15
online help, 1-12
printing from, 1-9 to 1-11

Magenta setting, 2-9
Maintaining printer, 6-1 to 6-10
Managing print jobs

Macintosh, 4-6 to 4-8
Windows 3.1 or 95, 1-7, 

4-1 to 4-5
Windows NT, 1-8, 4-5

Manual feeder, 3-11 to 3-13, 7-14
Manuals, how to use, 3 to 4
Margins

adjusting, 3-10, 3-13, 3-19
problems, 7-17
specifications, C-4 to C-5
with multiple sheets, 3-4

Mechanical specifications, C-6
Media Type setting, 1-3, 1-10, 2-3, 

2-5 to 2-6, 3-3 to 3-5
Media, see Paper or specific media 

name
Memory, 2, 7-11
Messenger service, Windows NT, 

1-8, 4-5
Micro Adjust buttons, 

3-20 to 3-21, 5-4
MicroWeave setting, 2-6, 7-4
Mirror images, 2-6, 3-4, 3-33, 7-17
Monitor2 utility, 4-6 to 4-7, 7-9, 

7-16
Monitoring ink level, 4-5, 4-8
More Settings dialog box, 

2-4 to 2-11, 3-5
Moving printer, 6-10

l2ug.ix  Page 4  Friday, May 9, 1997  2:17 PM



Index

I-5

N Namer utility, EPSON, 4-14
Network I/F mode, 5-6, 7-6
Network path, 4-12 to 4-13
Network printing

Macintosh, 4-13 to 4-15
PC, 4-9 to 4-13

New Hardware Found window, 
7-10

No Color Adjustment option, 2-9
No Halftoning option, 2-6
Nozzle Check utility, 6-2 to 6-4

O Online help, printer software, 
1-11 to 1-12

Optional interfaces, using, 
A-1 to A-4

Orientation settings, 1-4, 1-9

P Page length setting, 5-6
Page Setup dialog box, 1-9, 3-29
Paper

choosing, 3-2 to 3-4
cleaning sheet, 3-5
feed speed, C-1
handling problems, 

7-13 to 7-15
jams, 1-13, 7-9, 7-15
legal, 3-6
letterhead, 3-5
menu, 1-3 to 1-4, 1-9, 3-27
plain, 3-3
special, printing on, 3-1 to 3-35
specifications, C-3 to C-5
thickness lever, 3-7, 3-11
thickness, see Thickness lever

Paper release lever, 3-6, 3-11, 3-14, 
3-22

Paper Size setting, 1-4, 1-9, 2-3, 
B-3

Paper size, custom, 3-28 to 3-30
Paper Source setting, 1-4, 1-9, 2-3, 

B-3
Parallel I/F transfer rate setting, 5-7
Parallel interface boards, A-1

PC serial interface board, 
A-1 to A-2

Perceptual setting, 2-11
Photo Quality Banner Paper, see 

Banners
Photo Quality Glossy media

choosing, 3-2 to 3-4
printing on, 3-5
specifications, C-3 to C-4

Photo Quality Ink Jet media
choosing, 3-2 to 3-4
printing on, 3-5
specifications, C-3 to C-4

Photo setting, 2-3
Photo-realistic color adjustment, 

2-8
Pitch, 5-5
Plot files, printing, 1, 5-1, 

B-1 to B-4
Portrait setting, 1-4, 1-9
Power Macintosh Extension 

module, 1-11
Predefined advanced settings, 

2-1 to 2-4
Print direction, 5-5, 5-7, C-1
Print head alignment

control panel, 6-9
DOS utility, 5-7 to 5-8
problems, 7-5
utility, 6-8

Print head cleaning, 6-1 to 6-4, 7-4
Print jobs, managing

Macintosh, 4-6 to 4-8
Windows 3.1 or 95, 1-7, 

4-1 to 4-5
Windows NT, 1-8, 4-5

Print quality problems, 7-4 to 7-7
Print Quality setting, 2-4 to 2-6
Print Using a Temporary File 

setting, 2-7
Printable

area, 3-6, 3-16, C-4 to C-5
columns, C-1

Printer
cleaning, 6-10
commands, 5-17 to 5-19
test, 7-1 to 7-3
transporting, 6-10
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Printer software, accessing
DOS, 5-1 to 5-2
Macintosh applications, 

1-9 to 1-11
Windows applications, 

1-2 to 1-4
Windows default, 1-5 to 1-6

Printer software, using, 1, 
1-1 to 1-12, 2-1 to 2-13, 
3-3 to 3-5, 5-1

Printer status
Macintosh, 4-6 to 4-8
Windows, 1-7 to 1-8, 4-4 to 4-5

Printing specifications, C-1 to C-2
Problems

communication, 7-2 to 7-3
diagnosing, 7-1 to 7-3
paper handling, 7-13 to 7-15
print quality, 7-4 to 7-7
printing, 7-8 to 7-12
solving, 7-1 to 7-17
unexpected printout results, 

7-16 to 7-17

Q Quality/Speed slider, 1-3, 1-11, 2-2

R Rendering Intent setting, 2-11
Replacing ink cartridges, 

6-4 to 6-7, 7-4
Resolution, 2-5, C-1
Reverse Order setting, 1-4
Roll paper

choosing, 3-3 to 3-4
printing on, 3-22 to 3-33
specifications, C-3

S Safety
approvals, C-7
instructions, 7 to 9

Saturation settings, 2-9, 2-11

Self adhesive sheets
choosing, 3-3 to 3-4
printing on, 3-5
specifications, C-3 to C-4

Self test, 7-1 to 7-3
Serial interface boards, A-1 to A-2
Service, 5 to 6
Sheet feeder, 3-6 to 3-10, 7-13
Single sheets

loading in manual feeder, 
3-11 to 3-13

loading in sheet feeder, 
3-6 to 3-10

printing on, 3-6 to 3-13
specifications, C-3 to C-4
switching to continuous paper, 

3-21 to 3-22
Skip over perforation, 5-6
Slashed zero, 5-3, 5-6
Smeared printouts, 7-6 to 7-7
Software, see Printer software, 

accessing or Printer software, 
using

Special effects settings, 2-4 to 2-7
Specifications

electrical, C-6
environmental, C-6
ink cartridge, C-5
interface, C-7
mechanical, C-6
paper, C-3 to C-5
printing, C-1 to C-2

Spool directory, 4-3 to 4-4
Spool Manager

problems, 7-8, 7-11 to 7-12, 
7-16

using, 4-2 to 4-4
Status Monitor

Macintosh, 4-7 to 4-8
problems, 7-1, 7-11
Windows, 1-7 to 1-8, 4-4 to 4-5

Support, EPSON, 5 to 6
System requirements, 2 to 3
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T Tear off position
adjusting, 3-21
auto tear-off, 3-14, 3-18, 

3-21 to 3-22, 5-3, 5-7
Technical specifications, 

C-1 to C-7
Temperature, C-4, C-6
Temporary files

print using, setting, 2-7
problems with, 4-3 to 4-4

Testing the printer, 7-1 to 7-3
Text/Graph setting, 2-3
Thickness lever, 3-7, 3-11, 7-4
Thickness setting, adjusting, 3-7, 

3-11, 7-4
Tractor feeder, 3-14 to 3-19, 7-14
Transfer paper, see Iron-On 

Transfer Paper
Transparencies

choosing, 3-2 to 3-4
printing on, 3-5
specifications, C-3 to C-4

Transporting printer, 6-10
Troubleshooting, 7-1 to 7-17
Twinax interface board, A-1

U User Defined paper size, 
3-28 to 3-30

Utilities
EPSON Namer, 4-14
EPSON Plot!, 1, B-1 to B-4
Head Cleaning, 6-2
Monitor2, 4-6 to 4-7, 7-9, 7-16
Nozzle Check, 6-2 to 6-4
Print Head Alignment, see 

Print head alignment
Status Monitor, see Status 

Monitor

V Vertical banding, 7-5
Vertical lines, misaligned, 2-6, 5-7, 

7-5
see also Print head alignment

Video/Digital Camera setting, 2-3, 
2-9

Vivid color adjustment, 2-8
Voltage, 7-9

W What’s This? prompt, 1-2, 1-12
Windows

checking printer status, 1-7
managing print jobs from, 

1-7 to 1-8, 4-1 to 4-5
network printing, 4-9, 

4-11 to 4-13
online help, 1-11 to 1-12
printing from, 1-1 to 1-8
setting default options, 1-5

Windows NT
checking printer status, 1-8
connecting to printer, 

4-9 to 4-10
managing print jobs from, 1-8, 

4-5
online help, 1-12
Print Using a Temporary File 

setting, 2-7
printing from, 1-1 to 1-6
printing problems, 7-8
setting default options, 1-6

World Wide Web site, EPSON, 6

X XL24E emulation, IBM, 5-6, 5-19

Y Yellow setting, 2-9

Z Zero setting, 5-3, 5-6
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